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1. Using This Manual 
This User Guide manual is the "How To" guide for The THERAPIST Pro 3.0. It is designed to be read on your computer screen and, while you are 
welcome to print it out or take it to your local copy shop for printing, a printed version may not look as nice as the screen version. The biggest 
concession to favoring screen reading over a printed guide is that the pages are in landscape (sideways) mode to better fit the size and orientation of 
most computer screens. The other is a heavy use of color which is fine for printed manuals but it's a lot more expensive to print in color. Printing it in 
black and white (and gray), will work but it won't be as pretty or as useful. 

Style Guide 
This manual uses certain style conventions to help make things more easily understood. The following are used throughout the manual. 

Menu navigation 
Whenever referring to navigating to a location or screen in the program, the program uses the following bold, italic Times New Roman font to 
indicate the series of menu choices or screens with each selection separated by the » character: 

The above example means to start by selecting the Setup menu followed by Lookup Lists, a first level sub-menu, and finally Resources, the second-
level sub-menu. The star icon shown to the right indicates that you can get to the same place by clicking the tool-bar button with the same star icon. 
The tool bar can save a lot of clicking so it is helpful to learn how to use it. 

Setup » Lookup Lists » Resources 

Often, like in the above example, navigation leads to a list screen. To indicate that your next action would be to select an entry on the list, this would 
be followed by an exclamation point in square brackets. 

To further indicate that once you have selected a record, you should click the 

Setup » Lookup Lists » Resources » [!] 

View (     ), Change (     ) or Delete (     ) buttons, the exclamation point 
would be followed by the word View, Change, or Delete. The Insert (     ) button is special because it does not require that you select a record first. 
This makes sense because the Insert button adds a new record to the list so there is nothing to select. 

When the direction is to navigate to a list then click a particular button, the button name will be in square brackets. For example: 

Setup » Lookup Lists » Resources » [! Change] 

This instructs you to click on 

File » Select or Add a Practice » [New Practice Wizard] 

Select or Add a Practice from the File menu then, on the practice list, click the New Practice Wizard button (     ). If the 
final step is to select a particular tab on the screen, it will be named and the word tab added but no square brackets. 
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Some lists, such as the patient list, have additional choices along the right side of the list. To indicate the selection you would see something like this: 

 

What this means is to navigate to the patient list, select a patient, and click Transactions List to see their services and payments. The patient icon is 
shown to the right above even though the specified navigation didn't finish at the patient list. We're pretty sure by now that you can figure out what 
it means. 

File » Patients » [!] » Transactions List 

Screens and Windows 
We will use the words Screen and Window interchangeably to refer to all screens, I mean windows, or oh heck, you can figure it out. 

Fields 
In this manual, when we talk about fields we can actually mean a couple of different but related things. Technically, a field is a collection of the same 
kinds of things in a database table. For example the patient's first name is a field as are the date of birth and social security number. More often in 
this document, we use the word field to refer to the thing on the screen where you enter or select the value to put into the database field. When we 
do, we will usually call it by the name of its screen label. So, to discuss the first name field on a screen, we would show it as First Name

Buttons 

. 

The THERAPIST uses "flat" buttons that don't stand out from the background or even have a border unless the mouse pointer is hovering over them. 
They almost always have an icon so you can identify them and sometimes they are shown in with blue underlined text similar to a link in a web page. 
All buttons have a name, even if you don't see it on the screen. When referring to a button by name we'll show the name just like field names except 
that, where useful, the button's icon will be shown in parentheses. For example, the Ok

Keyboard and Mouse 

 button (     ) is used at the bottom of forms to complete the 
form and save the data. 

In various places throughout the manual, we have referred to keyboard keys or key combinations. These are shown in red bold text. For example: 
Enter key is exactly what you think it is. Ctrl+C refers the combination of the Ctrl key and the letter C key. In combinations like this, the letter is 
usually capitalized in print but that doesn't mean you also have to hold down the Shift key. It's shown that way simply for clarity. In case you are not 
familiar with keys used in combination, it's just like using the Shift key to make a letter capitalized or to get the symbol shown on the top part of a 
key such as the $ sign. There are four shifting keys on most keyboards, not counting duplicate Shift, Ctrl, or Alt keys on either side of the keyboard. 
Yes, there are four but the fourth is kind of strange. It is the Windows

In addition to the keyboard keys, we will use a similar convention for the right and left mouse buttons. For example, many entry fields in 
The THERAPIST have a button to the left that looks up or calculates an entry. The keyboard equivalent is to press the 

 key usually shown with a  or similar logo for Microsoft Windows. 
The THERAPIST doesn't use this key so we won't say any more about it. 

F2 key when the selector is on 
that field or to Right Click with the mouse on that field. 
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Cross-References 
Sometimes, often in fact, in the course of showing you how to do one thing, the manual will reference a task or description of something that is 
discussed more fully in another part of the manual. Instead of writing the same description twice, there will be a cross-reference to that other 
section. These appear like this with the text of the heading underlined and in blue. This is sometimes followed by the page number of the referenced 
section. Here is an example: see General Instructions on page 6 for more information. You can click on the blue underlined text to immediately skip 
to the referenced section. 
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2. General Instructions 

Controls 
Everything you see on a window except the window itself is a "control" of one type or another, even if you can't interact with it. Buttons are controls 
as are tabs, entry fields, check boxes, radio buttons, and lists of all sorts. All of the text on a screen is part of one or more controls. If you can see it 
(and sometimes even if you cannot), everything is a control. So why mention it? Because this manual will be discussing controls when describing 
screens so it's a good idea to define what we're talking about. 

Moving Around 
Whenever you are on a screen, one of the controls on the screen, perhaps a button or an entry field or something else will have the focus. Just about 
the only kind of screen where there is no focus is a progress window with no buttons. Everything else has some control with focus. You can move the 
focus from one control to the next by pressing the Tab key on your keyboard. This key usually has a symbol on it something like  and is usually 
found just to the left of the letter Q key on the keyboard. The Shift+Tab

You can also change the focus and jump to anything that can receive focus (some control types can't) by moving the mouse pointer where you want 
and clicking the 

 key moves the focus in the reverse direction. In either case, pressing the key 
eventually cycles back to the original focus. The order in which controls are selected is referred to as the "tab order" and is usually in the order you 
would normally read a screen. 

left mouse button

Left Handers If you are left-handed, Windows lets you switch the functions for the left and right mouse buttons with the 
mouse settings in the Control Panel. This manual will assume the normal orientation of these buttons. 

. 

Another way to change the focus is by using the hot keys. These are letters or numbers used in combination with the Alt key. When you see a field or 
other thing on the screen with a name or description with a single letter or number underlined, that underlined character is the hot key when you 
hold down the Alt key and press the underlined character. For example, in the Patient Information screen, the prompt before the patient's first 
name field is First Name. Notice that the letter F is underlined so pressing Alt+F (actually, it is Alt+f

When there is more than one control on the same screen with the same hot key, pressing the hot key combination will cycle between all of them. 

 but the capital letter is easier to read so that's 
how we will refer to them in this manual) will immediately take the focus to the first name field. 

Window Tabs 
Many of the windows in The THERAPIST use multiple tabs along the top. Tabs can serve a couple of different functions. The most obvious, and the 
most common, is to organize information. The Patient Information screen, for example, has several tabs: General, Phone & Email, Billing, etc. 
Without the tabs, putting all this information on one screen would make a huge and unwieldy screen and breaking it up into separate windows 
would just be ridiculously difficult to use. 
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The other way The THERAPIST uses tabs is on list screens to present multiple views of the list data. Sometimes they select a different sort order. The 
patient list, for example, has two tabs, one to display the list in name order and other to show it in patient ID order. Other times each tab presents a 
different subset of the list. On the Transaction list, for example, the tabs are All, Starting Balances, Services, Payments, and Interest. The All

You can change tabs by clicking on a tab or using the 

 tab 
shows all of the transaction types while the other four each show only one specific transaction type. 

Alt+Right Arrow and the Alt+Left Arrow

Lists 

 to scroll through the tabs. 

Lists are everywhere in The THERAPIST so it's a good idea to know how to use them. There are several types of lists in The THERAPIST: 

• Standard lists such as the patient list 

• Expandable tree lists such as the glossary (Setup » Templates » Glossary
• Drop-lists such as the 

) 

Patient Type

• Drop-combo lists such as the 

 selection at the top of the Patient Information screen. 

Preferred Name

In most cases, standard and expandable tree lists let you add, change, and delete records. Sometimes you can also view records without the 
possibility of changing them. In selection mode, the 

 selection on the Patient Information screen. 

Select

Add a new record to the list. You can also use the 

 button will be available letting you select a record. These are done with the buttons 
below: 

Insert or Ins

Change or edit the currently highlighted record. 

 key on your keyboard to do the same thing. 

Delete the currently highlighted record. The Delete or Del

View the currently highlighted record without being able to change anything. 

 key on your keyboard accomplishes the same thing. 

Select the currently highlighted record, close the list window, and continue with whatever process you are doing. 

Some Lists, such as the patient list, have a command bar along the right side of the list. The command bar lets you access other information and 
functions related to the primary list. For instance, on the patient list, the command bar gives you access to responsible parties, insurance, 
transactions, and other things related to the highlighted patient. It also lets you print an insurance claim or some reports for just that patient. 
Command bar items are grouped into sections and you can expand or contract the sections to see more or fewer of the items. Just click the heading 
to expand if it has been contracted or contract if it is already expanded. 

Lists also have two modes of operation: edit mode and selection mode. Edit mode is the normal way you will encounter lists. This is where you 
would normally add, change, and delete records from the list or perform some other activity related to a record you have highlighted on the list. An 
example of the latter is when you highlight a patient and click on Transactions on the right to work with services and payments for the selected 
patient. 
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Selection Mode 
Selection mode is special. This list mode is where you can select one or sometimes more than one record for some kind of processing. When 
presented so that you can select a single record, there will be a Select

When you are requested to select multiple records, rather than using a 

 button (      ) usually on the left side below the list. 

Select button, each record on the list will have a check box. Place a check in 
the box by clicking on it or pressing the Space Bar key on your keyboard. There will then be either an Ok

List Navigation 

 button (     ) or a more descriptive button to 
allow you to proceed with the operation. 

You can use the Up Arrow, Down Arrow, Page Up, and Page Down keys on your keyboard to scroll up and down the list one line or one page at a 
time. You can scroll to the very top of the list using Ctrl+Home or Ctrl+Page Up and to the very bottom of the list with Ctrl+End or Ctrl+Page Down

Lists that are longer than the number of rows that can be displayed on one screen also have a scroll-bar along the right edge of the list. Because 
many of the lists in The THERAPIST can have a very large number of records (hundreds or thousands of patients, for example, or many thousands of 
procedure and diagnosis codes), the only way to make the scroll bars an accurate representation of your position in the list would be to load the 
entire list into memory at the beginning. Trust us, it would be so slow and unresponsive that you would hate us if we did that. The result is that the 
program guesses where it is in the list and it is seldom correct. 

. 
You can also click on a list line with the mouse to jump to that line. 

This doesn't mean that the scroll bar is useless. Clicking above the scrolling scroll-bar button is the same as pressing Page Up on the keyboard and 
clicking below this button is like pressing Page Down

For these longer lists, a better way to get to a desired entry quickly is to start typing. On the patient list, for instance, when sorting the list by last 
name, just type the first few characters of the name and watch as the list scrolls closer and closer to the patient you want. In ID number order, type 
the patient's ID if you know it. Other lists work pretty much the same way. 

. 

The patient list is unique in that you can also search for patients in a number of ways. Take a look at the Search grouping on the right side command 
bar for the available search options. 

Finally, depending on your user-interface settings, you may see a group of small buttons (                                 ) in the lower left corner of lists 
throughout the program. They are referred to as VCR buttons because they work similar to the buttons on video and audio players. Clicking them 
will, in order, go to the beginning of the list, scroll up one page, go to the next record up, go to the next record down, scroll down one page, or go to 
the last record in the list. 

Active and Inactive Records 
At the top of my lists is a check box labeled Show Inactives (                                 ) or something similar. When you see this check box, it means that 
whatever things are being listed can be made inactive to hide them on the list. Checking the box will make the inactive records visible so that you can 
make them active again, edit them, or just view the inactive records. 
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Forms 
As important as it is to understand how to use lists, knowing how to use forms is at least as important. The really good news, however, is that they 
are much simpler. Basically a form is a window where you enter some information. Update forms have fields corresponding to a database table and 
are used to add and change records in the table. These update forms have three modes:  adding a record, changing a record, and viewing a record. 
Another type of form is the option form. They are used to set up options for a report or other process. Those forms don't have different modes but 
always behave as if they were in the "changing a record" mode even though they may not be altering a database table. 

Simple forms might have all fields and Controls on one screen while more complex forms may have many tabs, each with its own set of fields and 
controls. 

Forms all have at least two and usually three buttons in the lower right corner of the screen. 

This is the Ok button. It will save the results on update forms. On option forms the selections are passed to the process you are running. 

This is the Cancel button. This cancels and discards any changes. On option forms, it cancels the process you are running. 

This is the Help button. Clicking it will open the help window for the screen you are on. Like this manual, it is a work-in-progress. 

There can be other buttons on forms and they are usually labeled with text to indicate what they do. 

Lookups and Fill-Ins 
Many of the entry fields in The THERAPIST offer to fill in the entry for you via a lookup or a value based on a calculation or from other fields. These 
fill-in fields have buttons just to the left of the entry and there are different buttons for different kinds of fill-ins. 

This is a list lookup button. It lets you select a value from a list. 

This is a date lookup button. Use it to select a date from a calendar. 

This is a calculated fill-in button. It uses other data to calculate the most likely value for this field. It is a best-guess but unfortunately, it is not 
always the value you want. 
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Required Fields 
Many of the fields in The THERAPIST must have something entered or selected in order to complete an entry form. These required fields are always 
shown with a colored background. The default color is light blue but you can change it in User Interface options: Setup » Preferences » User Interface

User-Defined Fields 

. 

This topic is sufficiently complex that it merits its own chapter. See User-Defined Fields on page 119. 

Tool Tips 
When you hover your mouse over a control that can receive focus, a description 
of that control will pop up and remain for about ten seconds or until you move 
your mouse away from the control. 

When the field directly or indirectly appears in insurance claims, the tool tip for 
that field will show you where in the claim it will appear. For CMS-1500 claims, it 
will be something like CMS:24j as in the example screen. This means box 24j on the CMS-1500 form. For ANSI X12 Claims, it can get more involved 
because there are often more than one place in the claim where a field can appear. The example screen above shows the Rendering Provider NPI. As 
the tool tip indicates, it can appear not only in box 24j on the CMS-1500 but the X5010 means that it also appears in X12 (version 5010A1) claims. 
X5010:2310B/2420A.NM109 tells us that in the X12 claim, the slash in 2310B/2420A means that it can appear in the 2310B loop as well as in the 
2420A loop. The dot after the loop identifiers says that the next part will be the segment in which it appears. Because only the loop IDs have multiple 
instances, while there is only one segment ID it means that in both loops, it will appear in the NM1 segment in position 09, the 9th element in the 
segment. Hey, don't blame us, we didn't make this stuff up. We're just trying to help you make some sense of it. 
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3. Running The THERAPIST the First Time 
Once you have installed The THERAPIST, you will want to run it and begin working immediately. To run The THERAPIST, go to your desktop and look 
for the colorful program icon: 

There are other ways to run the program that differ depending on what version of Windows you are using. Regardless of which version of Windows 
you have, you will be looking for the colorful program icon above.  

Windows XP, Windows Vista, and Windows 7 

Click the Windows Start button or press the Windows logo key on your keyboard then go to: 

Windows 8.0 

All Programs » Beaver Creek Software » The THERAPIST Pro 3 » The THERAPIST Pro 

Go to the colorful Windows home screen and right-click in a blank area away from the tiles. A popup at the bottom lets you go to All Apps. You will 
probably need to scroll far to the right to see a group labeled Beaver Creek Software. Below it will be icons for several programs related to 
The THERAPIST Pro 3. Click on the program icon shown above. 

Windows 8.1 

Go to the colorful Windows home screen and move your mouse to a blank area below the tiles. An icon should 
appear near the lower left that looks like a down arrow in a circle. Click this icon to go to the Apps. Primary 
programs are listed alphabetically. Scrolling to the right will take you to even more icons. Look for the program 
icon shown above. 

However you get there, the first thing you will see is the startup menu shown here to the right. If you press the 
Enter

NOTE: To restore data the first time, use the Administrator Utility. After logging in with the name 
ADMIN and the password ADMINPASS, go to 

 key or click the top button, you will go directly into The THERAPIST. However, if you have a previous 
installation of The THERAPIST Pro 3 and will be restoring data to this version, you should restore the data first; it 
will save time later. 

Backup and Restore » Restore Offline Backup

Unless you have already restored data, when you run The THERAPIST for the first time, it takes you through the setup wizard. The wizard lets you do 
the initial setup step by step. Each screen is either some instructions on what will come next or has instructions at the top relating to the choices on 
that screen. It is important that you read these instructions thoroughly. 

. 
After the first time, you can backup and restore from within The THERAPIST. 
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The first screen you see is an introduction and some initial instructions on how to navigate the wizard. When you have finished reading it, click the 
Next

Initial Data Source 

 button at the bottom to move to the next screen. 

The choice of initial data source simply asks whether you are starting from scratch and entering everything yourself or whether the data already 
exists and will be either restored from a backup or imported from another program. 

DEMOS: If you are installing a demo, you will not see this screen. Demos always start with the Sample Practice, a limited 
practice where you can try things out and learn about features without affecting read data. You can enter a real 
practice if you like by going to 

You can choose one of three options on the Initial Data Source screen: 

File » Select or Add a Practice » [New Practice Wizard] 

1. Enter the data yourself or use the Sample practice (neither importing nor restoring) 

Choose this if you are installing The THERAPIST Pro 3.0 and have no existing data to restore or import. This includes if you are running an 
evaluation version (demo). You will later have the option to add one or more practices and you will be able to switch between all practices, 
including the sample practice. One practice is included and you can purchase additional practices as needed. 

IMPORTANT! Don’t add a new practice if you will be importing or restoring a practice. Since the number of practices is 
limited to what you purchase, you will have to delete the added practice before importing or purchase an 
additional practice. 

2. Restore data backed up from another installation of The THERAPIST Pro 3.0 

If this is a secondary installation, you can bring in your data by restoring global and practice backups created by The THERAPIST Pro 3.0. 

3. Import data from a different version of The THERAPIST or from another program 

Choose this if you have data in The THERAPIST for Windows 1.0, or 2.0, The THERAPIST Pro 2.5, or The THERAPIST EZ that you want to import. 

NOTE: There is no import for data from The THERAPIST for DOS or from Aeris Basic. Contact 
technical support if you have a need to import from either of these programs. 

Make your selection then click the Next

Import Source 

 button. 

This screen is shown only if you selected the option to import data on the previous screen. It lets you select the source of the data you will be 
importing. Make your selection then click the Next button. 
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Key Code 

DEMOS: If you are installing a demo that you downloaded, you will not see this screen. Demos sent to you on a CD do 
include a key code and you should enter it on this screen. 

Key codes are comprised of seven blocks of five digits each. Each block of five digits is entered into its own box on the screen. If a key code was sent 
to you in electronic format, you can copy from there and paste it on this screen using the Paste button to the right of the code. If, instead of a code, 
you were sent an activation file, you can load the file using the blue folder button below the code. Activation files work like codes but have some 
extra information. 

Once you have entered a valid Key Code or selected an Activation File, click the Next

Licensee 

 button to continue. 

On this screen, please enter the information requested. Most of these boxes are self-explanatory but can benefit from a bit more information. Please 
note that boxes with a blue background must be filled-in. 

Licensee The Licensee is the person or organization that owns the license to use The THERAPIST. 

WARNING! If you are a consultant or someone other than the business owner, DO NOT enter your 
name as the Licensee. Put in your client's name here instead. Better yet, ask them what name to 
use because once this wizard is complete, it is not easy to change the licensee name. 

Address This is the address of the business or the address where we should send correspondence. Sometimes this is a home address if that 
is where you prefer to receive mail. 

Contact This will be the primary contact for your business. It can be the same as the licensee or different. Some people put an office 
manager's name here. 

Phone/Fax Enter your primary area code and telephone number and, optionally, a fax area code and number. 

Email Enter your best email address here. Please use an address that you check regularly as this will be the email address to which we 
send newsletters and announcements. 

Click the Next

Type of Business 

 button to continue. 

This selection is primarily information to help Beaver Creek Software assist you better. It is also used to make small but useful changes in how the 
program behaves to make your workflow easier. Click the Next button to continue. 
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Initial User 

Even though the program has a built-in user with the login name of Admin, it is important that each person who uses the program has their own user 
name and login. On this screen you enter information about the initial login user you want to add. You can add more users later by going to 
Setup » Security » System Users

IMPORTANT! In an office with more than one person using The THERAPIST, each user should have their own user listing 
and login. This gives you granular control over what each user is allowed to do in the program and allows 
you to track who made changes to a patient's account. 

. 

The initial user you enter here will be part of the System Administrator security group and will have full access to all parts of the program, including 
security settings. The program comes with several built-in security groups and, with the exception of the System Administrator and No Access 
groups, you can edit them to set specific access rights. You can also add your own security groups. 

Click the Next

Security Question 

 button to continue. 

Sometimes our customers forget their login password or need assistance with security-related issues in the program. To prevent unauthorized 
people from gaining access to your program by telling us they are you, we ask that you give us a question and its answer. We will ask callers for the 
answer to the question if they call for security-related issues. 

IMPORTANT! Don't use something that everyone around you knows. Everyone knows the name of your dog and what 
your middle name is. But they probably don't know the name of your first grade teacher or the make and 
model of your first car. Be creative. 

Click the Next

Registration 

 button to continue. 

It is important that you register your installation, whether you purchased the program or you are evaluating a demo version. For purchasers, it is 
required in order to continue using the program after an initial period because we cannot generate your Access Code without information from your 
registration. 

DEMOS: Registration qualifies you for free technical support for the life of your evaluation and it 
does not obligate you to anything. It specifically does not mean you agree to purchase 
or to pay for anything. You have nothing to lose and plenty to gain by registering. 

Click the Next button to continue. 
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Business Associate Agreement 

The Business Associate Agreement is a HIPAA compliant document. The main purpose of the agreement is to say that Beaver Creek Software is 
bound by the same privacy and security restrictions that you are with respect to protected health information (PHI, i.e. your patient-related 
information) that we may come in contact with. With an executed agreement in place, you need not worry that you will accidentally disclose 
protected information when you speak to technical support or others at Beaver Creek Software. 

When you click the button, our Business Associate Agreement will open in Adobe Acrobat where you can fill it out, print it, and sign it. Then just fax it 
to us for our president's signature and we'll fax it back. You can also scan it an email it or even sign it digitally and email it to us for our signature. 

NOTE: A signed Business Associate Agreement must be in place before technical support is allowed to provide 
remote access support or to open your data should you send it to us for analysis or repair. 

Click the Next

Finish 

 button to continue. 

Click the Finish button after reading the instructions to complete the setup and register your installation. 

Whenever you enter the program, you will be asked to log in. The first time, unless you have created yourself as a user, log in with the following: 

Login Name: ADMIN 
Password: ADMINPASS 

It doesn't matter whether you use upper, lower, or mixed case values for the login name. If you have strong passwords enabled 
(Setup » Preferences » Program Preferences » [Security tab]), passwords will be case-sensitive. Because the Admin login gives you complete access to all 
of the functions of the program so you should change this password as soon as possible. Eventually, the program will force you to do it. Be sure not to 
use an obvious password such as your middle name, the name of a spouse or child, your birth date, or your address. Also, if you write the password 
down, don't keep in where anyone can find it. If you should lose your password, Beaver Creek Software can give you a code which will let you change 
your password. 
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What Comes Next 
At the beginning of the setup wizard, you chose where your initial data was to come from. What happens next depends on the choice you made at 
that time. 

Enter the data yourself or use the Sample practice 
If you are starting with The THERAPIST for the first time, you indicated (or should have chosen) to enter the data yourself or use the Sample Practice. 
If this was your choice, the program will open to the Sample practice. You can use the Sample practice to evaluate the capabilities of the program. 
Once you have added a real practice, you can return to the Sample practice at any time to practice a new task and try things without being 
concerned about harming your real data. 

You can add a real practice by going to File » Select or Add a Practice and clicking New Practice Wizard button. See Adding a Practice on page 22 for 
more information. 

If the New Practice Wizard

Restore data backed up from another installation of The THERAPIST Pro 3.0 

 button is disabled, it means that you have already user the number of practices you have licensed. Contact Beaver Creek 
Software customer service if you need to license additional practices. 

If you chose to restore data, the file selection window will open and allow you to select a backup file. You can only restore a backup file made by 
The THERAPIST Pro 3.0. If you want to load data from another version of The THERAPIST, you should be importing it instead. 

There are two kinds of backup files based on the data that was backed up. A global backup file name will contain the words "Global Data" in 
parentheses but without the quotes. Global backups include your program preferences, security settings, your list of login users, as well as lists of 
procedure and diagnosis code lists, drugs, countries, zip codes, and some other lists used internally by the program. 

Practice data backups, on the other hand, contain all data that is specific to a particular practice. There can be one or more practice data backups. 
The file name for a practice data backup will have an eight-digit practice ID and the practice name in parentheses. 

Since this is the first time data will be loaded into this installation of The THERAPIST, you should restore both the global data backup and all of your 
practice data backups. Most offices will have only one practice data backup. It doesn't really matter which order you restore them but remember 
that once you have restored the global data, logging in to The THERAPIST will require the normal login names and passwords from the other 
computer that created the backup. 
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Import data from a different version of The THERAPIST or from another program 
You can import data from the following versions of The THERAPIST: 

• The THERAPIST for Windows 1.0 and 2.0 
• The THERAPIST Pro 2.5 
• The THERAPIST EZ 2.5 and 2.6 

Importing from the following is not supported: 

• The THERAPIST for DOS 
• Aeris Basic 
• Programs from other companies 

Completing the Initial Setup 
There are several additional steps you must take to complete the initial setup of the program. If you will be restoring data from another computer, 
these steps have more than likely already been completed. If you will be importing data from another version of The THERAPIST, most of these will 
be imported but you would be wise to go through them to make sure they are the way you want them. Here is a listing of the most important things 
you should look at and where in the program to find them. 

Program preferences and Security Settings 

Security Groups 

Setup » Preferences »Program Preferences 

Login Users 

Setup »Security »Security Groups 

WARNING! Be sure to change the password for user Admin otherwise anyone who reads this installation guide will 
have total access to your program and can change anything and everything. 

Setup »Security »System Users 

Because The THERAPIST does not include procedure and diagnosis codes (though they are available for purchase), you might also want to look at 
these lists and add the codes you use. 

Diagnosis Codes 

Procedure Codes 

Setup » Lookup Codes » Diagnosis Codes 

 

Setup » Lookup Codes »Procedures Codes 
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4. Security 
The THERAPIST is designed with powerful security to guard information against access by unauthorized users. Much of the power comes from the high 
degree of flexibility and granularity you have to specify what each user is permitted to do in the program. 

Security Options 
Setup » Preferences » Program Preferences » Security tab or 

The basic security settings are part of the program 
preferences. This tab will not be available unless 
the logged-in user has the necessary security rights 
to edit program security. 

Setup » Security » Security Options 

Default Security Group 

As the name indicates, this selection is simply the 
security group used as the default whenever you 
add a new user. It's good to keep it at "Standard 
User" to make it less likely that someone will 
accidentally make a new user a system 
administrator. 

Login Passwords 
Login passwords are required for all users. This is 
necessary to ensure the minimal level of security 
required by HIPAA for protected health 
information. 

If you enable Require users to change their  
passwords

NOTE: The program keeps track of previously used passwords and will not let users reuse an old password. 

, the program will require that users 
change their passwords periodically. The setting 
can specify from 1 to 999 days between required password changes. When a user logs in, if it has been more than the required number of days, the 
program will open a screen where the user can enter a new password and confirm it by entering it a second time. It may be a pain in the backside 
but requiring users to periodically change their passwords will make your system more secure. 
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If you enable Require strong user login passwords

• Passwords must be from 6 to 20 characters in length (your choice); more is better. 

, passwords will have to conform to the rules you specify: 

• If enabled, passwords must contain both upper and lower case letters. 
• If enabled, passwords must contain at least one numeric character. 
• If enabled, passwords must contain at least one punctuation or other character. 

Message Logging 
Message popup screens are used to present useful information, warn users of the consequences of certain actions, and indicate that an error has 
occurred. The THERAPIST Pro has the ability to store a log of the messages it displays. You can enable or disable message logging and specify how 
long to retain logged messages. 

To view the message log, go to Help » About The THERAPIST » [Information] or choose Support Information from the startup menu. The Message 
Log list shows all the messages shown by date and time with the text of the message itself below the list. Using the mouse, you can double-click or 
right-click on a message line or clicking the View Details

File Change Audit Logging 

 button (     ) in the bottom left corner of the screen, you can see the message details. 

Many of the data files in The THERAPIST are monitored for changes and a log of those changes is maintained for review. Actually, there are two logs, 
one for global data and another for data specific to each practice. You can disable this log but there is almost no benefit to doing so. Logging the 
changes takes a fraction of a second each time a record is added or changed so any time savings is miniscule and not noticeable. The benefits of 
having the log, however, far outweigh any downside. On lists and entry forms for audited files, you will see an icon that will let you view a list of the 
changes for the file or the single record. 

This icon appears below lists and lets you view changes to the highlighted record or to all records for that list. 

This icon appears at the bottom of update forms and lets you view changes to the current record. 
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System Users 

It is important that everyone who uses 
The THERAPIST has their own user login 
and password because you can: 

Setup » Security » System Users 

1. set who may do what 

2. track changes made by a user 

3. prevent people from seeing things 
they shouldn't have access to. 

4. link users to resources and to 
providers. (See page 38 for details). 

The identity information on the user 
update form is mostly self-explanatory 
with the possible exception of the check 
box to indicate that the user is a 
healthcare provider. If you want to link this 
user to a resource and a provider, this box 
must be checked. Other users can be 
linked to a resource but not to a provider. 

You can indicate whether you want to see 
the tip of the day each time the user logs 
in and, if so, which kind of tips to display. 
You can also determine what kind of 
messages to display. Some messages that 
are informative but not strictly necessary 
can be skipped by setting Display Messages to Critical messages only. You cannot turn off all messages. 

The security group determines what level of access the user has. Reserve System Administrator for people who should be able to modify other users' 
security settings. 

The Digital Signature Password is for providers to digitally sign case management records such as treatment plans and progress notes. 

The check box at the bottom to hide passwords only appears when a user is editing their own record. It allows you to see the passwords you enter 
instead of just the dots shown in the example screen above. 
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Security Groups 
Security groups let you control security access for a group of users in one place. The THERAPIST comes with five built-in security groups but you can 
add as many more as you need. The five built-in security groups are: 

System Administrator Users assigned to this group have all access to everything in The THERAPIST. You cannot change this group. 

Master User Users assigned to Master User have access to all functions except changing security settings. You can change the access 
rights for this group. 

Standard User Users assigned to Standard User have access to the most commonly needed functions. This is the group often used for 
office staff. You can change the access rights for this group. 

Minimal User Users assigned to Minimal User have very limited access. This group is commonly edited to give access to a single 
function such as viewing the appointment calendar. You can change the access rights for this group. 

No Access Users assigned to this group have no access to The THERAPIST. You cannot change this group. 

When adding or changing a security group, you will see the screen below with the group name at the top. In the example screen below, the name is 
not editable because it is one of the built-in security groups. 

The list shows all of the possible security "Doors". You can grant access to a door by putting a check in the check box. The doors are categorized to 
make it easier to find things. The Type column shows you whether the door is applicable globally or wither it is specific to the currently selected 
practice. Practice-specific doors become more meaningful and useful when you consider that each user can be assigned to a different security group 
for each practice they log into. So, for instance, they could be assigned to a Master User in one practice and to No Access in another while having a 
general group assignment of Standard User. The user's main security group assignment will apply to any practice for which there is no practice-
specific group assignment. For practice-specific group assignments, the global doors have no effect. 
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5. Adding a Practice 

The THERAPIST lets you run a single practice or multiple practices each with its own separate data files. When you install The THERAPIST the very first 
time you will have the opportunity to add your first practice. You can, if you wish, delay this and just use the Sample practice. 

File » Select or Add a Practice » [New Practice Wizard] 

WARNING! The Sample practice is limited in the number of records you can enter. It is there for you to try things and 
learn about the program without affecting real data. Also, the sample practice data is not backed up so 
don't try to put real data in the sample practice. 

Adding Your First Practice 
This section is for those who are starting from the beginning with no data from any version of The THERAPIST to either import or restore. 

IMPORTANT! Don’t add a new practice if you will be importing or restoring a practice. If you do, you may have to 
purchase an additional practice or delete the new practice before you will be able to import or restore a 
practice. 

To set up a new practice, you will use the New Practice Wizard. You can get there by selecting “Add the first practice now” when first running 
The THERAPIST. It is available from the File menu: 

The New Practice Wizard will walk you through the process of setting a variety of options. The first wizard screen is simply gives some basic 
instructions before completing the wizard. Read them then press Next to continue. 

File » Select or Add a Practice » [New Practice Wizard] 

Practice Demographics 

Enter the name and address of the practice then press Next to continue. 

Contact Information 

Enter the primary contact information and the practice's NPI then press Next to continue. 

Remittance Name and Address 

If you use a separate name and address to receive payments from patients and insurance, check the box and enter it here. Press Next to continue. 
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Billing No-Shows and Cancellations 

Here you can indicate whether you bill for no-shows and late cancellations and how the program should calculate the amount to bill. 

Statement Billing and Aging 

On the left, indicate whether service fee amounts on patient statements should include the full amount of the service, including amounts assigned to 
insurance or only the patient (or responsible party) amounts. A similar selection on the right indicates whether and how the program should 
calculate aging charges on past-due amounts. 

Dunning Messages 

If you calculate aging, you can tell the program to add one of four messages to patient statements based on the longest amount of time past-due 
amounts have been owed. When used, these usually get progressively more severe as the number of months increases. 

Interest 

On this tab, you indicate whether you charge interest or finance charges on past-due amounts. On the left, tell the program whether you charge 
interest and on which amounts to base the charges. On the right, are four quantities that determine how the program will calculate interest Charges. 
Read the screen description for each of these to decide what to enter. 

Taxes 

So far as we know, In the United States, only Hawaii charges tax on medical services though it is being considered elsewhere. If you are required to 
collect tax on the services you render, check the box and enter the tax rate here. Also, since the tax has to be paid, indicate whether the patient will 
be responsible for the taxes that are not paid by insurance. 

Patient's Signature on File 

You are probably familiar with boxes 12 and 13 on the CMS-1500 form where the patient or responsible party can sign to authorize release of 
medical information and payment of benefits respectively. If you have a signed authorization form in the patient's file where these are authorized, 
you can put "SIGNATURE ON FILE" in both of these boxes. There is a corresponding code for these on electronic claims. 

On this wizard screen you indicate whether these boxes for signature on file default to being checked when you add new patients. 

Finish 

Click the Finish button to complete the wizard and add your practice. However, there are more options available than are presented by the Wizard. 
After the wizard is complete, you can see all of the practice options from the Setup menu: 

Setup » Preferences » Practice Preferences 
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What's Next 
Only the most critical options and settings are addressed in the New Practice Wizard. There is still a lot to do or at least to look at to make certain 
that everything is the way you want it. To really complete adding the practice, see Practice Preferences on page 25. 

Now that the practice has been created and you have gone over the practice preferences, you are ready to begin adding information about your 
practice. However, before you get too excited and jump right to entering patients, there are a couple of things you have to do before you add your 
patients. 

Resources and Providers 
Before you can enter patients or patient-related information, you must enter the providers in your practice and before you do that, you have to 
enter them as resources. You enter resources and providers from the Setup menu: 

Setup » Lookup Lists » Resources (Adding a provider resource will also add the corresponding provider, at least the first one) 

For more information on resources and providers, see the section titled 

Setup » Lookup Lists » Providers 

Resources and Providers on page 38. 
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6. Practice Preferences 

Only the most critical options and settings were completed while adding a new practice. There is still a lot to do or at least to look at to make certain 
that everything is the way you want it. 

Setup » Preferences » Practice Preferences 

General Tab 
If you want payments from patients and 
insurance to go to a different address 
than the main practice address, check the 
Use separate remittance…

Billing Tab 

 check box and 
enter the name and address where you 
want it to go. The phone number and the 
optional extension, if you enter them, are 
included on X12 electronic claims. 

The settings on the Billing tab were set 
during the wizard that created the 
practice (even if you imported the 
practice from an earlier version). 

Bill No-Shows 

Select whether you want to bill no-
shows to the patient and/or responsible 
parties. You can bill a percent of the 
normal fee for the service (including 
100%) or an arbitrary fixed amount. 

Bill Cancellations 

Select whether you want to bill late 
cancellations to the patient and/or 
responsible parties. You can bill a 
percent of the normal service fee or an 
arbitrary fixed amount. 
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Tax Collections 

Indicate whether you are collecting taxes on services. Then enter the tax annual percentage rate as a percent of the fee. You can also indicate 
whether patients are responsible for taxes not paid by insurance. If you elect to not charge the patient for the taxes not paid by insurance, you pay 
the tax and it is recorded as a tax-loss write-off. 

Amounts to Display on Patient Statements 

Indicate here whether you want patient statements to show the full fee amounts due or only the amounts owed by the patient (or responsible 
parties). 

Patient Account Aging Basis 

Aging refers to assigning an age to monies owed to you by patients and responsible parties. The THERAPIST assigns the money to one of five aging 
categories:  Current (zero to 29 days), 30 to 59 days, 60 to 89 days, 90 to 119 days, and 120 or more days. 

The option here is to determine whose debt is counted in the aging. Each service indicates the amounts owed be the patient, responsible parties, 
and insurance. Using this information, you can tell the program to base its aging calculations on the total amount owed, only the amount owed by 
the patient (and responsible parties), or not to do any aging. 

Charge Interest 

Interest calculations are intimately connected to aging described above. Ordinarily, the selection here should match the Aging Basis. However to 
give you the maximum flexibility to manage your accounts, you can set interest independently of the aging setting. If you indicate that you are 
charging interest on either the full fee or the patient amount, you can then set the parameters for your interest calculations. 

The THERAPIST calculates interests based on fees being due on the day services are rendered. You can use the interest settings to modify this 
assumption. 

Annual Interest Rate 

Enter the interest rate as a percent. Your state probably regulates the maximum interest rate you can charge. 

Interest Start Days 

This is the number of days after the date of service that the program begins calculating interest. For example, if you set this to 60 and a service is 85 
days past due, then no interest is calculated until after the 60th

Interest Free Days 

 day but it is still calculated on 85 days, not 25 days (85 days minus 60 days). 

This is a number of days after the date of service for which no interest is charged even if it has been owed for a longer period. For example, if you 
set this to 30 and a service is 90 days past due, then interest is calculated only on the last 60 days. 

Minimum Finance Charge 

A minimum finance charge is useful if a patient (or responsible party) owes an interest amount less than your costs to prepare and send a 
statement. Your state may regulate the amount you are allowed to charge. 
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Minimum Finance Days 

When computing interest, the program determines the number of days since the last interest calculations. If this is equal to or greater than the 
Minimum Finance Days and the interest amount falls below the minimum finance charge, the finance charge is the minimum finance charge rather 
than the interest. Your state may regulate the Minimum Finance Days. 

Dunning Tab 

Dunning messages, if entered, are printed on patient statements based on the highest aging category for which money is owed. For example, if a 
patient owes anything in the 30 and 60-day aging categories but nothing in either the 90 or 120-day categories, the 60-day dunning message is 
printed on the statement. 

Dunning messages are used to encourage patients to pay and tend to get more severe with increasing age. 

Practice ID Tab 
This Practice ID tab is where you enter a variety of identification numbers for the practice. None of these ID number are used for rendering 
providers. Rendering provider ID numbers are ID Numbers tab described on page 46 in the chapter about providers. 

The Practice NPI may be the same as a 
rendering provider NPI for small offices 
but even small offices may be better off 
applying for an NPI for their practice. 

The Employer ID Number or the Social 
Security Number is reported on all 
printed and electronic claims. 

The Taxonomy Code is reported on X12 
electronic claims in the Billing Provider 
loop 2000A. 

The list of codes In the bottom part of 
the screen correspond to all of the 
possible secondary ID numbers defined 
for printed and electronic claims for the 
billing provider. The choice of which to 
include on a claim is determined by the 
Provider ID Preference selection on the 
Claims tab for each Carrier record. 
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Defaults Tab 
Most of the fields on this tab are straightforward 
initial values used when you add a new patient, 
service, or payment. However, a couple of them 
deserve special mention. 

Automatically assign the next patient ID number 

You can use any patient ID formats you want if you want to assign each patient ID yourself. But if you want The THERAPIST to assign the next ID 
automatically, IDs should be at least 6 characters long and must use a consistent length and format. Otherwise you will not get consistent results. 

Prepayments are applied to service on 

This affects how income is calculated. 
When you apply a prepayment to a 
service, do you want the income to be 
listed as the date you applied it or the 
original payment date? The date you do it 
is normally the calendar date but you can 
set an arbitrary working date for adding 
transaction-related records. 

Add Missing Procedure to Fee Schedule 

When you use a procedure code on a 
service and that procedure code doesn't 
have a fee entered for the patient's fee 
schedule, this setting tells the program to 
either use the update the fee schedule 
using the service fee, to never update the 
fee schedule, or to ask you each time it 
happens. 

Default Diagnosis Code Source 

When you add a new patient diagnosis, 
this setting will determine whether it 
defaults to using ICD-9 diagnosis codes or 
those from ICD-10. 

This setting does not affect any existing 
patient diagnosis. 

A Patient ID number is a value used to uniquely identify a patient's account. It can include 
letters, numbers, and other characters. Because it is not a simple number, finding the next 
number after something like MP-9520-Z is tricky. That's because the IDs are sorted as text 
not numerically and it starts with the leftmost character rather than the rightmost. 
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Scheduler Tab 
The top third of this tab determines how 
the appointment calendar works. For 
each of the three resource types, you 
can set, via the check boxes, whether 
you can schedule patient appointments, 
group appointments, and new patient 
appointments. 

This is also where you set the normal 
office hours. These times will determine 
which time period will use the standard 
office closed and open background 
colors on the appointment calendar. The 
office open and closed colors are 
independent of the availability schedule 
for any resource. 

The times when the office is open will 
use the Unavailable Times Background 
Color (see the Colors tab below). For the 
times the office is closed, a darker 
version of the same color is used. 

Appointment Reminder File Export 

If you use an appointment reminder 
service, The THERAPIST can create a file 
of upcoming appointments that you 
can upload to your service. The settings 
here control what is in the file. 

The Starting Days and Ending Days settings determine the number of days in the future to use as the default starting and ending appointment 
dates when you export the file. So, using the values of 3 and 7 above, if you export on the14th of the month, three days later means that the export 
start date will be on the 17 th and the end date will be seven days from the export date, so it will be on the 21st

A common practice is to include the names of the fields as the first row so that the data starts on the second row. You can set whether to include 
the field names in the first row by checking the 

. 

Include Field titles as the first record exported

The export file is a Comma Separated Values (CSV) file, a standard format commonly used to share information between different programs and 
systems. The file name can use tokens as shown in the example to include the starting and ending dates for appointments in the name. 

 check box. 
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Colors Tab 
You can use the settings on this tab to customize the appearance of your 
appointment calendar and how user-defined fields will appear when you 
have changed the value and haven't yet saved the record. 

Click where it says Click Here to Select Color (it almost hurts to have to 
tell you that) to change one of the colors. The buttons to the right of 
each color (     ) will reset the color to its default value. 

There are two other colors that are not set on this screen and those are 
the color for required fields and read-only fields. They are not set here 
because they are not specific to any practice but affect the entire 
program including global data. You can read about setting those colors 
and other user-interface options by going to the chapter named User 
Interface Settings on page 121. 

Banking Tab 
Bank Information 

The top portion of the Banking tab is where you enter your bank 
name and account number. These are printed on deposit slips. 
Account numbers use special font that includes only numbers plus 
four special characters represented by the letters A and C and the 
two keyboard symbols – (a hyphen) and [ (open square bracket). 

The account number you enter should actually start with the 9-digit 
bank routing number, usually both preceded and followed by the A 
symbol. This is sometimes followed by several blank spaces. After 
that is your account number (which may include the - symbol) and 
finishing with a [ symbol. As you enter the numbers and symbols, 
you will see it shown below as it will appear on your deposit slips. 

Credit Card Processing 

The THERAPIST has the ability to directly process credit card payments through Singular Payments credit card processor. It is quick and easy to set  
up your merchant account by calling them at 877-328-8778 or visiting their web site: http://www.singularpayments.com/beaverlog. There is no 
charge to set up the account and only a very small merchant charge for payments processed. This is standard and you will have a merchant charge 
regardless of which processor you use. To do it through The THERAPIST, however, you must use Singular Payments. You can watch a video showing 
how easy it is to use at http://www.youtube.com/watch?v=4PlRomxOJjw. 

http://www.singularpayments.com/beaverlog�
http://www.youtube.com/watch?v=4PlRomxOJjw�
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Miscellaneous Tab 
Authorization Expiration Warnings 

This group of five amounts let you 
determine at what point you want to 
be warned that patient's authorizations 
are getting close to being completed. 
These are warning levels. 

When the authorized amounts are fully 
used up, the check box asks if the 
authorizations status should be 
changed to Closed. 

ODBC Data Source 

An ODBC Data Source is a means by 
which you can access The THERAPIST 
data files from other programs such as 
Microsoft Excel. Adding a Data Source 
requires that The THERAPIST ODBC 
Driver be installed. This is available for 
purchase from Beaver Creek Software. 

Default Charge Distribution 

When you add a new service that is not 
from a memorized service, the program 
tries to figure out the most likely way to 
split amounts owed between the 
patient, responsible parties, and 
insurance. This setting tells the 
program whether the patient and 
responsible parties are charged only 
the patient copayment amount or the 
full service fee. Whatever left over is 
charged to insurance. 
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Facility Type 

When a new patient is added, the Case record is added automatically. You can also add another Case 
record yourself (if you have the Case Manager add-on). In either situation, this practice setting 
determines the default facility type setting in the Case record. Choose Directly entered in the case if 
you want to enter the facility name and address differently for each patient. Choose Other

Default Office Location 

 to select a 
facility from your list of facilities. The button to the right of the drop-list lets you edit the facilities list. 

If you have only one office, it doesn't matter if you choose Main office (or whatever you may have 
named it) or [No Office Selected]. 

Practice Data Folder 

This is here only for your information. If you need to actually look at the data files, click the button to the right to open this folder in Windows File 
Explorer. 

WARNING! Unless you really know what you are doing, don't monkey with the data files. Even if you do know what 
you are doing, be very very careful. 

User-Defined Tab 
See the chapter on User-Defined Fields on page 119. 

Notes Tab 
This is just a big note field where you can write whatever your hopes, your dreams, your aspirations. 

HINT: If you want to use your practice 
as the facility but use a different 
address or way of naming it, add 
it to your facility list so you can 
easily select it both here and in 
any existing case records. 
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7. Importing Data 
You can import data from any of the following: 

• The THERAPIST for Windows 1.0 or 2.0 
• The THERAPIST Pro 2.5 
• The THERAPIST EZ 2.5 or 2.6 
• CSV (Comma Separated Values) file with patient information 

Importing Data from The THERAPIST (All versions) 
To import data into The THERAPIST, go to the Tools menu and select Import Data. The first screen you will see will let you choose the physical source 
of the data you will be importing. The data can be read from an installation on the same computer or from backups of the data made by the program 
you are importing from. 

In addition to selecting whether you will be importing from local or network 
data or from backup files, this screen also lets you import the global data again. 
If you do that, it will overwrite the global information such as procedure and 
diagnosis codes, system users, and program preferences that you may have 
previously imported. 

Installation on this computer or network 
If at all possible, choose to import from an existing installation on the same 
computer or on a network drive accessible from this computer. It will make the 
import simpler because everything it needs is already in place. 

If importing from The THERAPIST EZ, the Data File Source option on the Import 
Data Source screen will say "Backups from The THERAPIST EZ 2.5 or 2.6". 

NOTE: If possible, do the import on the computer where the data is 
stored. The program has to read and write a log of information 
during an import and doing it across a network, even a fast 
network, can make the import many hours longer than it would 
if you were importing from data on a local hard disk. 
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When you click the Start Import

NOTE: The original data you are importing will not be changed in any way. The import makes a 
temporary copy of the original data and converts it to a format that can be imported. 

 button, you will be presented with a series of progress screens showing that the import data is being analyzed and 
copied to a temporary location prior to being imported. 

If the data you are importing has multiple practices, you will then get to select which practices to import. If there only a single practice (not counting 
the sample practice), then you will not see this screen. 

On the Select Practices to Import screen above, practices that have already been imported are shown with a green check mark. Click the check boxes 
to select or de-select the ones you want to import now. While it is possible to import multiple practices at the same time, it is generally a good idea 
to import only one practice at a time. 

When you are ready to start, click the Begin Import button. The files from the practices you have selected will be copied to a temporary location and 
converted to an intermediate format prior to being imported. Depending on the amount of data and the speed of your computer, this can take 
several minutes. 
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Importing from Backup Files 
If you import from a backup, the first screen you will see is the one on the 
right where you select and load your global data backup. This is necessary 
even if you have already imported global data because the import program 
needs some of the information from the global data to correctly import 
whatever practice backups you load. 

When you click the Load Global Backup button, a Windows file selection 
screen will open where you can navigate to and select your global data 
backup. It should be named Backup (Global Data).tbz unless it has been 
renamed. Find and highlight the file and click the Open button or double-
click

Notice on the screen on the right that the 

 the file itself to load the global data into a temporary location. 

Import Restored Data

Once you have loaded the global data, it will appear on the Restore Data 
list on the left side of the screen. In the sample screen on the left, the 
Global Data is shown in gray indicating that the global data has already 
been imported and will not be imported again. 

 button is 
disabled. It will remain disabled until you have loaded the global data 

backup and at least one practice data backup. 

Click the Load Practice Backup

Backup (28787019) Your Practice Name.tbz 

 button for each practice you want to import 
now. The screen on the left shows that one backup has already been 
loaded. Practice backup files are named something like: 

Notice that once you have loaded the global data and at least one practice 
backup, the Import Restored Data button is no longer disabled. When 
ready, click the Import Restored Data button to begin the import process. 
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All Imports From The THERAPIST 
Whether you are importing from a local installation or from backups, and regardless of the version of The THERAPIST you are importing from, the 
rest of the process is the same. It starts with analyzing the data. This can take a couple of minutes and is followed by converting the data to a 
common intermediate format prior to actually importing it into The THERAPIST Pro 3.0. We have to do these intermediate file formats because every 
version and release (2.5.001, 2.5.002, etc.) of The THERAPIST can change the structure of one or more of the data files. This conversion step can take 
several minutes, go have a cup of tea. 

When the data conversion step is finished, you will get a screen on which you indicate whether the patients being imported have received the 
necessary HIPAA privacy notice and, if so, what date to use as privacy notice date. To set this yourself patient-by-patient, leave this unchecked. 

If the practice you are importing has 
multiple providers, you will be presented 
with the screen on the right. This screen 
is where you match resources with 
providers. Before going on, please, 
please, please read about Resources and 
Providers on page 38. 

Select each resource on the left and 
check the box or boxes for providers on 
the right who are the same person as the 
selected resource. 

When you are finished, some resources 
may link to more than one provider and 
some resources may link to no providers 
at all. Resources with no providers will 
not be added. 

Once you click the Continue

When it finishes, you will be given the opportunity to view the Data Import Log.txt file using Windows 
Notepad. This can be interesting, especially if any errors were found during the import. If you want to see 

this file later, it is stored in the program's data folder. 

 button, the import should proceed with no additional input from you. The 
process can take anywhere from a few minutes to several hours or even overnight if you have a really big 
practice and/or a really slow computer. 

IMPORTANT: Each individual should 
be represented by one 
and only one resource 
even if they link to 
multiple providers. 
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What's Next 

In order to see your newly imported practice in The THERAPIST, you have to select that practice. It's easy to switch practices. From the 

File » Select or Add a Practice 

File menu, 
click on Select or Add a Practice or click on the toolbar icon with the red check mark inside a green diamond. The currently selected practice has a 
green check next to it. Select the one you want then click the Select Practice (      ) button. 
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8. Resources and Providers Overview 
Resources in The THERAPIST is a simple concept but may not be immediately obvious. We'll start with an overview and work our way down to the 
gritty details. 

In the broadest sense, resources are people and things that you can schedule on the appointment calendar. A resource can be a healthcare provider, 
another person on your staff, or something else such as a room or a piece of equipment. In previous versions of The THERAPIST, resources did not 
exist, as such and providers were scheduled in the appointment calendar. This was limiting in that other people and other things could not be 
scheduled. Having resources as their own entity solves that. 

Resources also give you more security options because you can link a resource 
to a logon user. That relationship then links providers and other staff resources 
to login users. When you do this, you have more granular control over who has 
access to private health information. This happens in part because resources 
are the connection between login users and providers. A logged-in user can be 
a resource and a resource can be a provider. 

Not all users need to be resources and not all resources need to be users but, 
other than a small initial setup time, there is no disadvantage to having all 
users be resources. While a resource does not need to link to a user, it is 
important to remember that each user can be linked to only one resource and 
each resource can be linked to only one user. Also, the built-in Admin user 
cannot be linked to any resource; this is yet one more reason to not use Admin 
as a regular login name. 

The diagram on the right might make it clear. The system user Alice (in blue), is 
a resource (in pink) and also a healthcare provider (in green). Bob is also a user 
and a resource but has two provider records. Why you might want to have the 
same individual entered as more than one provider are many and varied. For 
instance, if a therapist works out of a satellite office one day a week, you might 
want to set them up as a separate provider for each office. The collection of 
providers attached to a resource is referred to as provider aliases. 

System user Claire may be a billing person or receptionist. She uses 
The THERAPIST but her time is not scheduled on the appointment calendar. 
Resource Edie is not a system user. She never logs into The THERAPIST and cannot do so. She is also listed as two providers. System user Grace is also 
a resource so that she can be scheduled for appointments but she is not a healthcare provider. 
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9. Adding a Resource 

From the resource list, click the 

Setup » Lookup Lists » Resources 

Insert

If the resource you are adding is set as a healthcare provider, 
the first provider record will be added automatically when you 
click the 

 (      ) button 

Ok

The first and most important choice is to correctly set the 
Resource Type. A resource can be either: 

 button. You will then be taken to the entry screen 
for that provider where you can complete the remaining entries 
needed finish adding that provider. 

• A healthcare provider 

• A person who is not a healthcare provider 

• A physical resource such as a room or a piece of equipment 

If this is a provider or another person, be sure to select the 
System User that is the same person as this resource. If this is a 
human resource that does not login to the THERAPIST, you can 
choose the selection, "Resource is not a system user". 

If you would like to include a photo of the resource, you can 
choose the image file by clicking the button labeled Select 
Photo

Add telephone numbers and email addresses to the Phone and 
Email list. For healthcare providers, it is important to add at 
least one telephone number, the one you want to appear on 
insurance claims. 

 (      ). The THERAPIST can use almost any image file 
format. 

IMPORTANT: The Resource Type and System User 
selections cannot be changed later so 
be sure you choose correctly. 
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Payroll 
The THERAPIST can calculate and report payroll for human 
resources, both for healthcare providers and others. For 
provider resources, payroll can be calculated by the resource 
or by provider. This only matters if you have multiple providers 
entered for the same resource. If the resource relates to a 
single provider, it doesn't matter whether you set the type to 
By Resource and select the payroll template here or choose By 
Provider and set the template in the provider record. Of 
course, if it's not a healthcare provider, you are limited to No 
Payroll and By Resource. 

For the payroll template, if you haven't already created the 
payroll template, you can either click the button on the right 
(    ) or, from them menu, go to Setup » Template » Payroll. See 
Payroll on page 47 for more information about payroll and 
how to set up payroll templates. 

Signature 
If this is a Provider resource, you can indicate that the 
provider's signature is on file and it will be shown on printed 
and electronic claims. If you enter a Signature Date, this will 
also be included on claims but if you leave it blank, the claim 
date will be shown there instead. 

Signature Image File 
If present, the signature image will be printed on CMS-1500 claim forms in box 31. 
Use the Select Signature File

Form Letter Signature Block 

 (     ) button to select an image file. 

In form letters as well as in treatment plan, progress note, and user-defined case 
management section templates; you can use field tokens that will be replaced with 
information from the database when those templates are used to create actual 
documents. One of those tokens lets you insert a provider resource signature 
block. This is where you enter the text you wish to use for this purpose. 

HINT: Even though The THERAPIST can use almost any 
image file format, choose a file with a transparent 
background so that the white space does not block 
out other text such as the claim date. Both GIF and 
PNG formats support transparent backgrounds. 
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Appointment Scheduler 
At first it might seem crazy to have a check box on a resource 
to enable the resource for appointment scheduling. After all, 
what else is a resource for anyway? The answer is, perhaps, 
not obvious. In The THERAPIST, providers have to also be 
resources but there are reasons (there must be, right?) why 
you might want to be able to schedule some providers but 
not others and thus be able to schedule some resources and 
not others. If you can think of a reason, this check box is for 
you. You can also indicate whether the resource will be 
included when exporting appointment call lists and so there 
is a check box for that too. 

If the resource is schedule-able, set the default appointment length in minutes. This doesn't mean you can't schedule any length appointment you 
want, this is just the most common amount of time you want to allot for new appointments. 

The long name, short name, and initials are used on the calendar. When showing many resources at the same time, the long name may not fit the 
space so the short name can be used. Similarly, if there is not enough space to show the short name, the initials can be used. 

Schedule Setup Tab 

There are two parts to setting up the availability schedule for a resource. The first is the for the resource's normal 
availability for each day of the week. If a day or time is not marked as available, it is considered to be unavailable. 
Use the top list on this tab to set the resource's normal availability. 

Adding a record to the Weekly Availability Schedule list will give you the screen on the left. This lets you mark as 
available a block of time on a selected day of the week. You can have more than one block in a day. For example, a 
block from 8:00am to 12:00pm and a block from 1:00pm to 5:00pm leaving an hour for lunch. 

You can also set aside blocks of time that you don't normally schedule appointments but are available for 
emergencies and special circumstances. These emergency blocks of time will show up as a different color on the 
appointment calendar. It's up to you to decide what makes an emergency so use this however you need to. 
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Schedule Setup Tab 

Weekly Availability Schedule 

If you have two or more days with the same block of time 
that you would like to make available for appointment 
scheduling, set up the first one the way you want, save it, 
then highlight it on the list and click the button at the button 
labeled Copy Availability

Availability Exceptions 

 (        ). This will give you a screen 
where you can select which other days of the week to copy 
the availability to. In the sample screen on the right, we 
added the morning and afternoon schedule for Mondays. We 
then copied the morning 8:00am to 12:00pm availability to 
the remaining weekdays and did the same for the afternoon 
availability. 

The second part of setting up availability is to add specific 
exceptions to the normal availability. For example, if a human 
resource is normally available from 9:00am to 5:00pm Monday through Friday but she doesn't want to work on her birthday, simply add this 
exception to the lower Availability Exceptions list. 
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As the screen on the left shows, the exception consists of the exception date, a choice of whether no 
appointments should be scheduled or to allow only emergencies, and finally, a short note. The note is 
important so that you'll know later why you entered the exception in the first place. 

If the date is available only for emergencies, the normal schedule for that date will apply except that all 
of the times will be flagged as available for emergencies only. 

Just like you could copy an availability schedule from one week day to others, you can copy an 
exception from one date to another date or date range. You might want to do this, for example, to 
block out a week of vacation or a conference. Click the Copy Exception

 

 (        ) button below the list and 
you can select the date range to copy to. 

 

NOTE: If there is no normal availability on the date of 
an exception , the Exception will have no effect. 
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10. Adding and Changing a Provider 

Before adding a provider, please read about 

Setup » Lookup Lists » Providers 

Resources and Providers Overview on page 38. If you have added the resource for a provider, the 
provider record should have been added for you automatically. However, there is no way the program can know how you want to set the various 
provider options so you should definitely go over them yourself. 

The left side of the screen shows the providers currently in the system. The right side shows the insurance carriers for which there can be a series of 
fields and settings that override individual provider settings when services for the provider are billed to the selected carrier. The green check next to 
Aetna US Health Care above indicates that at least one of these overrides has been set for Mortitia Addams for billing Aetna US Health Care. 

There is a tall, skinny button with four little blue arrowheads in the middle that will let you hide or show the carrier list part of the screen. 

The only good reason to add a provider here is if you need to have the same person listed more than once. However, there are plenty of reasons to 
modify a provider. To edit the highlighted provider, click the Change button (     ) below the provider list. 
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General Tab 
The provider name is set in the associated resource. You 
cannot change it here. If you were adding a provider, you 
would first be required to select the resource. 

If the provider has a supervising provider that must be 
reported on insurance claims, select that supervisor here. 
Naturally the supervising provider has to already exist in the 
system. A supervisor is handled automatically in X12 claims. 
For CMS-1500, you can force the supervisor into box 17. In 
that case, the supervisor's Rendering Provider secondary ID 
and NPI are reported in boxes 17a and 17b respectively. 

If you have only one office you can either select Main office (a 
selection that was added to the list automatically), or [No 
Office Selected]. 

Payroll may be calculated by the resource or by the provider. 
If there is only one provider for a given resource, it doesn’t 
matter which you choose. But if there are multiple providers 
for a resource (provider aliases), it does matter because it 
allows you to set break rate amounts based on the combined 
totals of all provider aliases. See Payroll on page 47 for more 
information about payroll and payroll templates. 

The payroll template for the sample provider on the right was 
selected for the resource so that selection is not available in 
the provider settings. 

There are two special claim codes. The Place of Service code is used as the default Place of Service for new services that are not based on a 
memorized service. The service field is used to populate box 24b on the CMS-1500. 

The Taxonomy Code field is troublesome. In X12 5010A1 claims, there are two specific locations where the taxonomy code should appear. However, 
on CMS-1500 claims, there is no single place for this code. Sometimes a payer wants it in box 19 and sometimes in 24j (in either box, it should be 
accompanied by the qualifier code ZZ). Sometimes, it shouldn't appear at all on the CMS-1500. It's all up to the payer so The THERAPIST doesn't use 
the qualifier code entered here on CMS-1500 claims. If you want it in box 19, it is entered in the patient's insurance information. To put it in box 24j, 
it should be entered on the ID Numbers tab for qualifier code ZZ for this provider. 

Indicate whether the provider is a Hospice Employee to put the necessary indicator in X12 claims. Choose Blank to omit this indicator on claims. 
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If you want to place a message on patient statements for this provider, enter it here. This will appear on all statements for this provider until it is 
cleared. When printing statements, you have the option to clear this box after the statements have been printed. A similar box in the patient record 
lets you put a message for just that patient on their statements. 

ID Numbers Tab 
Enter the Rendering Provider NPI at the top. It's called the rendering provider NPI to distinguish it from the Billing Provider NPI. Sometimes they are 
the same number but if the practice itself has been assigned an NPI, it should be entered in the practice preferences. 

The list below the NPI contains a variety of secondary ID numbers the provider may have. Each insurance carrier has a setting for their preferred 
secondary ID. If their preferred ID has been entered for the provider, it will be used on claims. 

CMS-1500 Tab 
Because there is so much variability in what provider 
information each carrier wants on the CMS-1500 form, these 
provider fields are used directly on the claim form unless 
overridden for particular carriers. 

The two lookup buttons (     ) let you select the qualifier code 
that identifies the provider's secondary IDs for boxes 24j and 
33b. These qualifiers must match the kinds of IDs you enter or 
your claims will be rejected. For example, if you are entering a 
Blue Shield Provider ID, you must use qualifier code 1B. 

The field fill buttons (     ) will fill the provider names in box 31 
and the first address line in box 33. The button for the second 
address line fills lines 2 and 3 from the practice address and 
the Billing NPI

User-Defined Tab 

 button fill the NPI from the practice's NPI. 

See the chapter on User-Defined Fields on page 119. 

Some carriers don't like it if the NPI or secondary IDs in 
boxes 24j match those in box 33. There is a Carrier setting 
that will cause the box 24j IDs (and the box 24i qualifier) 
to be blank if they are the same as the ones in box 33 
when claims are sent to that carrier. 
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11. Payroll 
The THERAPIST can calculate payroll for providers and generates the results as a report. You can then use the information to feed into your 
accounting program or payroll provider. 

Payroll calculations are based on payroll templates that you set up. A template is then selected for the resource or one or more providers (provider 
aliases) that are the same person as the resource. See Resources and Providers Overview on page 38 for more information on the relationship 
between resources and providers in The THERAPIST. 

The THERAPIST gives you the choice of whether to compute payroll that combines all providers of a resource or separately for each provider. The 
power of this becomes most apparent when you consider that you can set different payroll rates based on cumulative totals. The following examples 
should make this clearer. 

Example 1 
A provider is setup to receive 75% of income received for the first $1000 received 
per month then 90% thereafter. The resource relates to three provider aliases and 
is set to calculate totals across all provider aliases. Alias 1 receives $800 for the 
month, Alias 2 receives $1500, and Alias 3 receives $900. The total received is 
$3300 and the payroll is calculated as shown on the right. 

Example 2 
Using the same figures from example 1 and changing only the fact that the totals 
are calculated for each provider, we get the calculations: 

In these examples you can see that when payroll is calculated by provider, the 
total received can be significantly less than when they are combined. It would not 
always work out this way and it depends on the other payroll settings. 

When calculating payroll by the provider, you are not limited to using the same 
amounts and break levels or even the same method to calculate payroll for each 
provider. For example, one provider alias may use a percent of the amount 
received as in the examples above while another alias might have a fixed monthly 
amount and a third might be set to use an amount per unit billed. This gives you 
incredible flexibility in setting up and calculating your payroll. 

You can also calculate payroll for non-provider staff but this is limited to a fixed 
amount per period (month, etc.) because there are no other amounts on which to 
base the calculations. Naturally, non-human resources do not have payroll. 

Example 1 

Entire Resource 
Amount from $0 to $1000 $1000 x 75% = $750 
Amount above $1000 $2300 x 90% = $2070 

Total payroll $2820 
Total retained by the practice $480 

Example 2 

Provider Alias 1 
Amount from $0 to $1000 $800 x 75% = $600 
Amount above $1000 $0 x 90% = $0 

Provider Alias 2 
Amount from $0 to $1000 $1000 x 75% = $750 
Amount above $1000 $500 x 90% = $450 

Provider Alias 1 
Amount from $0 to $1000 $900 x 75% = $675 
Amount above $1000 $0 x 90% = $0 

Total payroll $2475 
Total retained by the practice $825 
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Payroll Templates 

Payroll templates allow you set up the details for how the program will calculate 
payroll amounts for a resource or provider and you have plenty of flexibility in 
how you set up your payroll calculations. 

Setup » Templates » Payroll 

General Tab 
Basis 

Your first important choice is the Basis setting. This determines which amount 
or quantity is used to calculate the total: 

Amount billed Full fee for service 

Payments received Patient and insurance payments received 

Billable hours Number of hours entered on a service 

Sessions Number of service sessions 

Units Number of units entered on a service 

Fixed base amount only Fixed amount per pay period 

Period 

The next choice is the pay period. This matters most because of how payroll 
rate breaks are set up. If you have a break after the first $2,000, for example, if 
that amount is calculated weekly the resource might rarely reach the break 
amount but if it is calculated monthly, it is much more likely to happen. For each 
period, break totals start at zero at the beginning of the period. 

Based on which period you choose, one or more fields on the form that are 
needed for calculations based on that period will be enabled while those used 
by other period calculations will be disabled. 
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There are four pay period choices: 

Weekly Payroll is calculated per week. You can select which day of 
the week starts the weekly pay period. 

Bi-Weekly Payroll is calculated for a two-week period. You must 
choose a date to start the cycle. 

Semi-Monthly Payroll is calculated twice a month. Because months vary in 
length, you choose the day of the month on which to split 
each month. 

Monthly Payroll is calculated for calendar months. 

Rate Chart Tab 
While the choices on the previous tab determined how the payroll calculations 
are done, the things you enter on this tab determine the fixed amounts and rate 
values to use in the calculations. 

The Base Amount is the amount that will be paid each pay period regardless of 
any amounts earned from services performed or payments received. This can be 
zero or another amount. If you will be calculating payroll for a staff member 
who is not a provider, this amount is their entire payroll amount for the period 
because there will be no services or payments to contribute toward their 
payroll. 

The three tabs below the base amount let you set different rate structures 
based on whether patients are "owned by" the provider resource. Patient 
ownership usually means that the provider was responsible for bring the patient 
to the practice and payroll based on services or payments for these patients is 
treated differently than for other patients. If you want to define it differently, 
that's fine. It really means that the program calculates payroll differently. 

In order to base payroll on ownership, you have to set up a rate schedule for 
both owned and non-owned patients. The three tabs determine which rate 
schedule is being viewed. 

NOTE: The THERAPIST calculates a payroll base amount. It does 
not calculate local, state, and federal payroll taxes and 
other deductions. Use the base amounts from the 
payroll report and enter them into whatever payroll 
system you use or give the report to your bookkeeper. 
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When you add your first rate, you will see the screen on the right. From the window 
title, you can see that this rate is for patients owned by the provider and starts at 
$0.00. If you will be entering only one rate, you would ordinarily leave the box 
checked to indicate that there is no upper break limit for this rate. 

Since this payroll is calculated based on payments received, the actual rate, 90% in 
this case, means that the payroll will be 90% of the total payments received. 

On the list screen above, the first rate starts at $0.00 and the payroll will be 75% of 
the amount received up through $2000.00. Above that (starting at $2000.01) the 
payroll will be 90% of the amount received with no upper limit. Because showing "no 
upper limit" on the list can be confusing, it shown as $9,999,999.99. 

Setting up Rate Breaks 
The scenarios below will demonstrate only some of the payroll possibilities but 
should give you a good understanding of how you can set up your payroll templates 
to accomplish what you want. We've used a basis of Payments Received but it 
doesn't really matter here how the amounts are determined. 

Scenario 1 
In this scenario, we're going to pay the provider resource $1000 no matter what he does. If he does more 
than $1000 worth of work, he will get 80% on the amount over $1000. 

We do this by using a $1000,00 base amount and setting up two break rates. The first is from $0.00 to 
$1000.00 and pays at a rate of zero. The second break rate starts at the next penny ($1000.01) with no 
upper limit and pays at the rate of 80%. 

The total payroll based on $2000 in payments received is $1800 while for $2500 received, it is $2200. 

Scenario 1 

Basis: Payments Received 

Base Amount: $1000.00 

Break 1 
Start Amount: $0.00 
End Amount: $1000.00 
Rate: 0% 

Break 2 
Start Amount: $1000.01 
End Amount: $9,999,999.99 
Rate: 80% 
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Scenario 2 
Scenario 2 says, we're going to pay you 100% on the first $1000 worth of work and 80% after that. 

This is accomplished by starting with a base amount of $0.00 and again setting up two break rates. The 
first break is just like in Scenario 1 except that it pays at the rate of 100% instead of 0%. 

The second break is identical with the second break in Scenario 1; same amounts; same rate. 

Scenarios 1 and 2 will result in the same payroll amount but only if the provider performs enough 
services or receives enough in payments (depending on your settings) to account for the first $1000. 

The payroll based on $2000 in payments received is $1800 and for $2500 received, it is $2200; just like 
Scenario 1. 

Scenario 3 
In this case the base amount is $0.00 but the rate is 80% of the first $1500 and 50% above that. 

The total payroll based on $2000 in payments received is $1700 but payroll is $2200 based on $2500 in 
payments received. At $2500 in payments received the payroll is the same in all of these scenarios. 

You can see that how you set up your base amount and rate breaks can make an enormous difference in 
the final payroll. Ignoring other overhead and expenses, the difference between amounts received and 
payroll out is profit for the practice. 

Scenario 2 

Basis: Payments Received 

Base Amount: $0.00 

Break 1 
Start Amount: $0.00 
End Amount: $1000.00 
Rate: 100% 

Break 2 
Start Amount: $1000.01 
End Amount: $9,999,999.99 
Rate: 80% 

Scenario 3 

Basis: Payments Received 

Base Amount: $0.00 

Break 1 
Start Amount: $0.00 
End Amount: $1500.00 
Rate: 80% 

Break 2 
Start Amount: $2000.01 
End Amount: $9,999,999.99 
Rate: 100% 
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12. Patient List 

The patient list is your home base from which you will do most of your work in The THERAPIST. The list works 
together with the right-side command bar to give you access to a variety of patient-related information and 
functions. 

File » Patients 

Editing the Patient List 
Below the command bar are four standard list buttons. Use them to view (     ), add (     ), change (     ), or delete (     ) 
patient records respectively. The change button exactly mirrors the top item, Patient Information

Command Bar 

, on the command 
bar. You will also be taken to the same patient information screen, although in different edit modes, if you use either 
the view button or add button. 

The command bar is the collection of headings and items along the right side of the list. It takes the place of the 
similarly placed buttons in earlier versions of The THERAPIST and is how you do just about everything related to 
patients. 

With the exception of the items in the Search group, each command item works with the currently highlighted 
patient. The search items, let you find a patient rather than working on any particular patient. 

Items on the command bar are in groups labeled Patient Information, Encounters, Case Related, etc. You can 
collapse groups so that only the group header is shown by clicking on the group header. You can expand collapsed 
groups the same way, by clicking on the header. The blue arrowheads (pointing up in the sample screen) will also 
indicate the collapsed or expanded state of the group. When collapsed they point down. 

Command bar items have shortcut keys that you can use instead of the mouse if you want to keep your hands on 
from the keyboard as much as possible. In an ironic twist, to find the shortcut key for an item, you must hover your 
mouse over the item (even disabled items) for a moment. A short description of the item pops up as a tool tip and 
the tip text includes the shortcut key for that item. For example, the shortcut key for Responsible Parties is Alt+R

As we discuss the individual command bar items, many of them actually have their own chapters and these chapters 

 
(hold down the Alt key and tap the letter "r"). Pressing this key combination will do the same thing as clicking the 
command bar item. 
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will be referenced rather than including a complete description here. 

Patient Information 
As mentioned above, this will take you to the same patient information screen as clicking the view, add, or change buttons below the list. This 
screen is described in great detail in the chapter titled Adding a Patient on page 54. 

Responsible Parties 
Responsible parties are described in detail in the chapter titled Adding a Responsible Party on page 55. 

Insurance 
Patient insurance is described in the chapter titled Adding Patient Insurance on page 56. 

Group Membership 
If you provide group therapy, this is where you can manage the current patient's group membership. If you have not yet any therapy groups, you can 
do it here but it is probably better to do so by going to Setup » Lookup Lists » Therapy Groups. See the chapter titled Therapy Groups on page 100 for 
more information. 

Medication 

General Notes 

Alert Messages 

Generated Claims 
DO NOT REMOVE THE Generated Claims HEADER ABOVE, IT IS REFERENCED ELSEWHERE. 
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13. Adding a Patient 
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14. Adding a Responsible Party 
PLEASE NOTE: The responsible party, if selected, will be used in the destination address on statements when statements 

are NOT separated by responsible party. Also, the selected party will be the used for patient and 
statement mailing labels. It will also be the responsible used on form letter tokens and on user-modifiable 
reports. 

 If no responsible party is selected, the first responsible party listed in priority order will be used as the 
default only on patient mailing labels, form letter tokens, and user-modifiable reports. 

 

 

RULES for dividing patient amounts due between responsible parties: 

1. The fixed amount of the responsibility is used first. This means that if a party has only a fixed amount, that is the maximum amount that the rule 
will allocate for the party. If there is both a fixed amount and a percent, it means that the party will be responsible for up to the fixed amount 
and a percentage of amounts above that. 

2. When multiple parties have fixed amounts and the amount to apply is less than the total of the fixed amounts, the amount to apply will be 
divided between the parties with fixed amounts in proportion to the relative fixed amounts of all parties. 

3. When multiple parties have fixed amounts and the amount to apply is greater than the total of the fixed amounts, the fixed amounts are applied 
first then the balance is divided according to the percents. 

4. Once all the amounts are calculated, the program looks to see if amounts have already been paid that are in excess of the amounts that the rules 
would indicate. If this is found to be so, the amounts due for the parties with excess payments are adjusted to match what they have paid. 
Amounts due for other payers are then adjusted lower to zero the net amount of the excess. 
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15. Adding Patient Insurance 
 



1. Adding a Responsible Party 
PLEASE NOTE: The responsible party, if selected, will be used in the destination address on statements when statements 

are NOT separated by responsible party. Also, the selected party will be the used for patient and 
statement mailing labels. It will also be the responsible used on form letter tokens and on user-modifiable 
reports. 

 If no responsible party is selected, the first responsible party listed in priority order will be used as the 
default only on patient mailing labels, form letter tokens, and user-modifiable reports. 

 

 

RULES for dividing patient amounts due between responsible parties: 

1. The fixed amount of the responsibility is used first. This means that if a party has only a fixed amount, that is the maximum amount that the rule 
will allocate for the party. If there is both a fixed amount and a percent, it means that the party will be responsible for up to the fixed amount 
and a percentage of amounts above that. 

2. When multiple parties have fixed amounts and the amount to apply is less than the total of the fixed amounts, the amount to apply will be 

16. Patient Case Information 
When you add a new patient, the initial Case record is added 
automatically but it is almost certainly incomplete. You will 
be taken to the case update form once you have completed 
the patient information screen. 

General Tab 
Title / Description 

The title is used to make it simpler to identify the case 
when selecting a patient's case on a list. If you have not 
purchased the Case Manager, patients can have only one 
case so it doesn't really matter what it says. 



1. Adding a Responsible Party 
PLEASE NOTE: The responsible party, if selected, will be used in the destination address on statements when statements 

are NOT separated by responsible party. Also, the selected party will be the used for patient and 
statement mailing labels. It will also be the responsible used on form letter tokens and on user-modifiable 
reports. 

 If no responsible party is selected, the first responsible party listed in priority order will be used as the 
default only on patient mailing labels, form letter tokens, and user-modifiable reports. 

 

 

RULES for dividing patient amounts due between responsible parties: 

1. The fixed amount of the responsibility is used first. This means that if a party has only a fixed amount, that is the maximum amount that the rule 
will allocate for the party. If there is both a fixed amount and a percent, it means that the party will be responsible for up to the fixed amount 
and a percentage of amounts above that. 

2. When multiple parties have fixed amounts and the amount to apply is less than the total of the fixed amounts, the amount to apply will be 

Case Opened / Closed Dates 

These are simply the dates the case was started and concluded. If it still open whether treatment is active, leave the Closed Date blank. 

Court ordered 

If treatment or evaluation was ordered by a court, check this box. 

Lock case 

You can lock this record so that other users can view or edit it only if they have been given the rights to do so. But you can do it only if you have the 
rights to lock record. 

Milestone Dates 

Enter dates for these as appropriate. In the first column, the bottom six are followed by unlabeled radio buttons with the seventh one labeled 
Leave CMS-1500 box 15 blank. Place the radio selector next to the date you want to print in CMS-1500 box 15 or select the bottom one to leave 
box 15 blank. The other dates fill corresponding date fields in printed and electronic claims. 

Physician Referrals 
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PLEASE NOTE: The responsible party, if selected, will be used in the destination address on statements when statements 

are NOT separated by responsible party. Also, the selected party will be the used for patient and 
statement mailing labels. It will also be the responsible used on form letter tokens and on user-modifiable 
reports. 

 If no responsible party is selected, the first responsible party listed in priority order will be used as the 
default only on patient mailing labels, form letter tokens, and user-modifiable reports. 

 

 

RULES for dividing patient amounts due between responsible parties: 

1. The fixed amount of the responsibility is used first. This means that if a party has only a fixed amount, that is the maximum amount that the rule 
will allocate for the party. If there is both a fixed amount and a percent, it means that the party will be responsible for up to the fixed amount 
and a percentage of amounts above that. 

2. When multiple parties have fixed amounts and the amount to apply is less than the total of the fixed amounts, the amount to apply will be 

Override Primary Insurance (Property and Casualty Insurance Only) 

If this case falls under property or casualty insurance, you can select that insurance here and it will be the primary insurance for claims under this 
case. You must first have entered this insurance in the patient's insurance list and checked the box labeled This insurance represents third part 
property or casualty insurance

 

 on the Eligibility tab for that insurance. 

 

 

Facility Tab 
Care Plan Oversight NPI 

Care Plan Oversight (CPO) is physician supervision of patients under either the home health or hospice benefit where the patient requires complex 
or multi-disciplinary care requiring ongoing physician involvement. This is the NPI of the home health agency or hospice providing Medicare 
covered services to the patient for the period during which CPO services were furnished. 
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17. Patient Diagnosis 
When you add a new patient, the initial diagnosis record is added but no diagnosis information is entered. You will be taken to the diagnosis entry 
screen after completing the patient's case information screen. 

In The THERAPIST, a patient's diagnosis is not necessarily a single 
diagnosis code but rather a collection of diagnosis codes and 
potentially other items depending on the diagnosis style you 
select. In addition, you are not limited to a single diagnosis. 
Because a patient's diagnosis can, and usually does, change over 
time, you can have multiple diagnoses for each patient organized 
by diagnosis date. 

The screen on the right shows a patient's diagnosis list with only 
one diagnosis and that diagnosis has two diagnosis codes. [Please 
don't read anything into the particular diagnosis codes for the 
sample, they were picked for illustration only.] 

The buttons below and to the right of the list let you view and 
edit the diagnoses on the list. The right-most of these buttons lets you see changes users have made to the highlighted record. 

When you add a new diagnosis for a patient, the diagnosis entry form will open. The top part of this form is shown below on the left. If you have not 
purchased the Case Manager add-on, the patient will have only one case record so the Patient Case

Diagnosis Date 

 selection will be disabled. If you do have the Case 
Manager, the patient's current case will be selected by default. 

Enter or select the date this diagnosis becomes effective. 
Services entered on or after this date will reference this 
diagnosis though you can select another if needed. No 
existing services will be changed regardless of the date but 
you can change them yourself if necessary. 

Code Source 

Select whether this diagnosis will use ICD-9 or ICD-10 diagnosis codes. A diagnosis 
cannot use a mix of ICD-9 and ICD-10 so pick one or the other. 

IMPORTANT: Once you have saved this diagnosis, 
you cannot change either the Code 
Source or the Diagnosis Style. 
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Diagnosis Style 

Select Medical, DSM-IV or DSM-5 diagnosis style. Your choice will determine which of the other tabs are available. 

Use Functional Assessments 

Functional Assessments are part of the DSM-IV diagnosis as Axis V, Global Assessment of Functioning (GAF). IF you select a DSM-IV diagnosis style, 
this box will be checked but disabled because they are always part of the diagnosis, whether you want to use them or not. Although a multi-axial 
diagnosis style went away with DSM-5, Functional Assessments are still around as Disability Scales in DSM-5 so this box will be checked but 
disabled. 

Functional Assessments are not an official part of medical diagnoses but have proven useful to record such things as range of motion and other 
measurements. If you choose a Medical diagnosis style, you can decide whether you want Functional Assessments to be available or not. 

Diagnosis Codes 
For Medical and DSM-5 diagnosis styles, the diagnosis codes are listed on a single tab, labeled either Medical or DSM-5. If you choose a DSM-IV 
diagnosis style, you will have three tabs for diagnosis codes labeled Axis I, Axis II, and Axis III. 

When you add a new diagnosis 
code to the list, you are first taken 
to the master diagnosis codes list 
(Setup » Lookup Codes » Diagnosis 
Codes

Diagnosis Code 

) where you can select the 
code you want to add. Then you 
will see the screen on the right. 

This should display the code you 
have selected. If you need to 
change the code, you can type it 
or click the lookup button (     ) to 
select a different code from the 
list. Any code you enter here 
must be on the master diagnosis 
code list. 

Standard Description 

This display-only field will show you the description from the master code list.  
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Override the standard description with a patient-specific description 

Some descriptions are generic, for example 302.901 for Sexual Disorder NOS. The NOS stands for "Not Otherwise Specified". If you would like to 
specify the particular disorder, check this box and enter your description in the Description Override

Make this diagnosis code selected (checked) on new services 

. You can enter up to 80 characters. This 
description prints in place of the standard description on Case Management and Authorization Request reports. 

This does just what it says and it is equivalent to the check box next to the code on the patient's diagnosis code list. 

Axis IV – Psychosocial Problems Tab 
This tab appears only if a DSM-IV diagnosis style is 
selected on the General tab. For other diagnosis styles, 
you will not see this tab. 

The Psychosocial Problems (also referred to as 
stressors) are defined in the Case Management 
template that is selected in the patient's Case record. 
The problems listed are those directly from the DSM-
IV manual with the full description for the highlighted 
problem shown below the list. You can define 
additional problems either for this diagnosis only or a 
adding a new problem to the template by using the 
Add a new problem

If you define a new problem just for this diagnosis, you 
can edit the problem name by highlighting it and 
clicking the 

 (     ) button. 

Change custom problem

To select a problem for this diagnosis, check the box 
on the left of the problem name. 

 button (     ). This 
button will be disabled until you have selected a 
custom problem. 
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Functional Assessments Tab 
This tab is visible only if functional assessments are 
enabled on the General tab. The name of the tab 
changes depending on which Diagnosis Style has been 
selected on the General tab: 

Style Tab Name 

The Functional Assessments listed are defined in the 
Case Management template, specifically, the one that 
is selected in the patient's Case record. 

 
Medical Functional Assessment 
DSM-IV Axis V – Functional Assessment 
DSM-5 Disability Scales 

Notes Tab 
For a given diagnosis, you can enter any number of notes. The notes are listed at the top and displayed at the bottom. Diagnosis notes use rich text 
which means you can format the text of the note however you like. For more information about rich text, see the section titled Rich Text Notes on 
page 122. 
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18. Transactions 
The five tabs at the top of the transaction list act as filters to show you all transactions or only one selected transaction type. When you select the 
Payments tab, you can further limit the list by the type of payer using the Payer Type

By default, only active transactions are shown. There are two ways a transactions can be considered active. The first is if the transaction has a balance, 
for example, services that haven't been paid in full or payments that haven't been fully applied to services or adjusted off (i.e. prepayments). These 
are active regardless of how old they are. 

 drop-list. 

The other type of active transactions consists of transactions that have a zero balance but are less than 30 days old. This lets you see the last 30 days 
of activity even for transactions that are fully paid or applied. The 30 days is arbitrary and can be changed. Consult the Administrator's Guide if you 
need or want to change the number of days. 

You can view the inactive transactions by checking the box with the unimaginative label, Show Inactives

Command Bar 

 in the upper right corner of the screen. This 
selection is independent of which tab you have selected. 

The command bar is the collection of headings and items along the right side of the transaction list. It takes 
the place of the similarly placed buttons in earlier versions of The THERAPIST and is how you do just about 
everything related to transactions. 

Items on the command bar will be enabled and disabled based on what you have highlighted on the 
transaction list or on other conditions. Notice that the entry for Add Service from Memorized is disabled on 
the sample screen shot on the right. It is disabled because, in this case, there are no memorized to use as 
templates for adding new services. Similarly, View Claims

Items on the command bar are in groups labeled Add Transaction, Modify Transactions, and Other. You can 
collapse groups so that only the group header is shown by clicking on the group header. You can expand 
collapsed groups the same way, by clicking on the header. The blue arrowheads (pointing up in the sample 
screen) will also indicate the collapsed or expanded state of the group. When collapsed they point down. 

 is disabled because there are no claims for the 
highlighted record (which you can't see here). 

When a command bar section is collapsed, the command bar gets shorter and the notes field below the 
command bar becomes taller so if you want to see more of the notes for the highlighted transaction, either 
make your transaction list taller or collapse command bar group headings. 

Command bar items have shortcut keys that you can use instead of the mouse if you want to keep your hands 
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on from the keyboard as much as possible. In an ironic twist, to find the shortcut key for each of the items requires that you hover your mouse over 
the item (even disabled items) for a moment. A short description of the item pops up as a tool tip and it includes the shortcut key for that item. For 
example, the shortcut key for adding a new service is Alt+S (hold down the Alt key and tap the letter "s"). Pressing this key combination will do the 
same thing as clicking the Add Service

Below the command bar are four standard list buttons. These let you view, add, changed, or delete records 
respectively. If you click the Insert (     ) button, you get a popup menu, shown on the left, where you can choose the 
type of transaction to add. Notice that it exactly mirrors the items in the Add Transaction command bar group even 
showing the 

 command bar item. 

Add Service from Memorized selection as disabled. 
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19. Starting Balances 
Sometimes, especially when switching to The THERAPIST from other software, you need to enter a patient's starting balance. This chapter deals with 
starting balances where the patient owes you money. If you need to set up a starting balance where the patient has a credit balance. Either you owe 
money to the patient, a responsible party, or insurance or perhaps the credit balance represents prepayment for services. That type of starting 
balance is done by entering one or more payments. See the section titled Using Payments As Starting  on page  Balances 95. 

The situation can be even more complex if the patient owes money to one of your providers but another provider owes money to the patient's 
account. In this case you add a starting balance record for the amount owed to a provider and add a payment for money owed to a patient.  

General Tab 
On this tab, you can select the provider to whom 
the patient's account owes money. You can also 
select the office if appropriate. 

The date is less obvious because in your previous 
system, the debt may have been incurred for 
several different dates. The date of this starting 
balance record is the date you want to use to 
calculate interest and aging so choose carefully. 

You can also enter one or more notes (or none at 
all) on the list. If you do enter a note, you can select 
it to appear on the patient's transaction list when 
this starting balance record is highlighted. With the 
note highlighted here, click the button labeled 
Select a note to show on the transaction list (     ). 
This will place a star next to the note on the list to 
show which one has been selected. 
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Money Tab 
There is a lot happening on the money tab so well talk about different parts of the screen separately. On the left side of the screen you enter the full 
amount of the starting balance. If you are unlucky and live in a locality that charges taxes on healthcare services and you have entered tax 

information in the Practice Preferences (see page 25) , this is also where you will enter the tax amount for the starting 
balance. The fill field button (     ) to the left of the tax amount (disabled and gray on the example screen) will calculate 
the tax for you. 

Below the amount and tax is a list 
where you can add adjustments to this 
starting balance. If you add an 
adjustment by clicking the Insert 
button (     ), you will get the screen 
below. Enter the amount of the 
adjustment and select whether the 
amount increases the net charge or 
decreases it. In almost all cases and in 
the example screen, adjustments 
decrease the effective charge amount. 
That selection forces the adjustment 
to be a negative amount. 

In addition to the amount, you can enter a comment that will appear on patient statements and a note that appears only on this screen. 

The first field below the adjustment list shows the total of all of the listed adjustments. The Payer Adjust

The box in the center changes depending on whether a patient 
or responsible party payer is selected or when an insurance 
payer is selected. The screen to the right shows the amounts for 
the patient payer. The payer selected is on the right below where 
it says 

 field shows the total of all the payer-
specific adjustments (discounts and write-offs) that are described below. The balance below the adjustments shows how the total amount owed, 
taking into account the adjustments above, is divided between the various responsible parties (including the patient) and insurance.  

Select Payer to Edit Amounts

In this example, the patient owes $10.00, nothing has been paid, 
there is no discount, and the balance $10.00. The discount is one 
of the payer adjustments mentioned above and shown on the 
left side of the screen. 

. 
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When the selected payer is insurance, the screen looks like the 
one on the left. Of the $227.50 total starting balance there was a 
$30.00 user-defined adjustment, $10.00 is owed by the patient, so 
the balance remaining to be applied to a payer is the $187.50 
shown in the Payer Fee Due

This payer has a $67.50 contract write-off adjustment so the 
payer's balance due is $120.00 and the overall balance on the 
Starting Balance record is $130.00. That equals $10 from the 
patient plus $120.00 from insurance. 

 for the insurance payer. 

Fields with a fill field button (     ) will calculate what the program 
believes is the most likely amount you will want in the associated 
field. 

 

Multiple Starting Balance Records 
Because each starting balance record deals with an amount owed to one provider, it is possible that you may need to enter additional starting 
balance records for other providers owed. Go ahead and enter them as needed. 
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20. Adding Services 
There are two places in The THERAPIST where you can add a service: the patient list and the 
patient's transaction list. The former is there to make it quicker and easier to add multiple 
services one after the other. The latter is more convenient if you will also be adding or 
changing other transactions for the same patient. 

Before delving into the details of the service, notice the Memorize this service (     ) button at the very bottom of the window. Once you get 
everything set in this service just the way you want it, click this button to memorize the service to it can be used to create new services. This button is 
not how you save the service itself. It makes a template to use for adding services in the future. See Memorized Services on page 81. 

General Tab 
However you get there, when you add a 
new service you will see the screen on 
the right. The actual field contents will be 
different, of course and will differ more 
based on whether you add a service from 
a memorized service or adding a service 
without a memorized service. For more 
on using a memorized service see Editing 
a Memorized Service 

From a patient's

Adding or editing a header opens the 

 transaction list, click 
Memorized Services (     ) option on the 
right side command bar. This will open 
the screen on the left where you can add, 
change, and delete memorized services. 
What you will see are the named 
memorized service headers along with 
the number of services in the bundle. 
Each header contains a bundle of one or 
more procedures. The tabs at the top let 
you choose either patient memorized 
services or system memorized services. 

WARNING! If you add services or payments from 
the patient list, you must be careful 
to first select the correct patient. 
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screen on the right. The header or bundle name is shown at the top. You can name this anything you want. It is used only to identify the bundle so 
you can select the right one when needed. 

The list part of the screen contains the procedures that are included in the bundle. There may be more than one but there must be at least one 
procedure listed. As you can see in the sample screen, when there is but one service, the delete button is not available. 

When editing a patient memorized service, it's pretty much the same as editing a service except there are not as many things to enter. For system 
memorized services, there are even fewer things you can access. Read the section titled Adding Services

Adding a Service From a Memorized Service

 on page 69. 

 on page 82. 

Just about everything on the service update form is important so We'll discuss each field in some detail. When describing initial or default field 
values, that assumes that the service is not being added based on a memorized service. 

Provider 

This is the rendering or performing provider. The provider defaults from the patient's principal provider. Use the drop-list to select a different 
provider if necessary. 
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Status 

There are four possible settings for the status, 

• Attended The patient actually attended the session. 
• Rescheduled The session was rescheduled. It will not show up on statements or claims and the amount is set to zero so it doesn't affect the 

patient or insurance balances. 
• Cancelled The service was cancelled late and may be billed based on your practice settings. 
• No-show The patient was a no-show so the service may be billed based on your practice settings. 

From Date / To Date 

These are the starting and ending dates of service. In almost all cases, they are the same date. 

Due Date 

This is the date payment is due for this service. It is almost always the same as the From Date. This date is used when calculating aging and interest 
on this service. 

Visits 

This is the number of visits or sessions covered by this service record. Unless you are doing something unusual, this should be 1. The number is 
used when calculating the number of visits used on authorizations when the number of visits has been authorized so that you know when the 
authorization will soon or has expired. 

Billable Hours 

This is the number of hours you want to consider as devoted to this service. It is used when calculating the number of hours used on authorizations 
when there is a limited number of hours authorized so that you know when the authorization will soon or has expired. It is up to you to determine 
whether, for example, a 50 minute appointment counts for 1 hour or 0.83 hours. 

Procedure Code 

Enter the HCPCS Level 1 (CPT), Level 2, or Level 3 procedure code here. You can look up a code from the procedure code list by clicking the Lookup 
button (     ), by pressing the F2 key on your keyboard, or Right Click

Modifier Codes 

 with the mouse on the code field. Your choice of procedure code may be 
dictated not only by the service you performed but also by what procedures are reimbursed by the patient's insurance. There are often multiple 
codes for virtually the same thing, one will be reimbursed at a low rate or even zero while another will have a much higher reimbursement rate. 

You can enter up to four procedure modifier codes. These modify or change the meaning of the procedure code. Not all modifier codes are 
applicable to every procedure code so it is important that you know which ones are and which are not if you are going to use them. You can look up 
a modifier code by clicking the Lookup button (     ), by pressing the F2 key on your keyboard, or Right Click

Override Description 

 with the mouse on the code field. 

Some procedure codes are generic. If you need to make it more specific, check the box and enter the description. Overridden descriptions are 
included in ANSI X12 electronic claims. The standard description is shown in the field when this box is not checked. 



Adding Services  Page 72 

Place of Service 

The place of service code appears on CMS-1500 claims, both printed and electronic, and on X12 electronic claims. It identifies the setting in which 
the service was performed. 

Emergency 

Typically, if the services was an emergency procedure, you would enter Y in this field and leave it blank otherwise. It appears on all insurance 
claims, both printed and electronic. 

Days or Units 

This is the number of units of service being performed. Usually, this should be 1. The number is used when calculating the number of units used on 
authorizations when the number of units has been authorized so that you know when the authorization will soon or has expired. 

Units (top line) 

On CMS-1500 claims, service lines have an upper, shaded, part and the white lower part. Normal box contents go into the white part. If you are 
asked to put something in the upper portion of Box 24g, this is where you enter it. This is typically a code and the known codes are available for 
lookup with the button provided. 

EPSDT (Early and Periodic Screening, Diagnosis, and Treatment 

This is for early child care services. Enter Y if this service falls under Medicare's EPSDT guidelines. 

EPSDT (top line) 

On CMS-1500 claims, service lines have an upper, shaded, part and the white lower part. Normal box contents go into the white part. If you are 
asked to put something in the upper portion of Box 24h, this is where you enter it. . This is typically a code and the known codes are available for 
lookup with the button provided. 

Family Planning 

If this service is part of family planning, you normally enter a Y in this field. If present it will appear on X12 electronic claims. 

Supplemental Information 

Supplemental information is whatever your payer requires. If entered, it will appear on the top line of box 24 and in X12 electronic claims. 

Statement Comments 

If you want a special comment to appear for this service on patient statements, enter it here. 



Adding Services  Page 73 

Diagnosis Tab 
The date at the top of the screen is a 
drop-list where you can select the 
diagnosis that applies to this service. If 
you need to edit that diagnosis, you can 
use the edit file button on the right (     ). 

The list shows you the diagnosis codes 
for the diagnosis selected above. Each 
code has a check box on the left. To 
indicate that a code applies to this 
service, add a check to its check box. 

When you add a service, the current 
diagnosis code is selected by default and, 
in that diagnosis, codes that are checked will default to being checked on new services. 

Money Tab 
The money tab is complex, has several distinct areas on the screen, and is likely going to be where you spend the bulk 
of your time adding and editing services. We'll break it down by the screen area to make understanding and using it as 
simple as possible. 

On the left side, you will enter the full fee for service amount and, if you have the misfortune to be somewhere that 
taxes healthcare services, the tax on the full fee amount as well. The tax fields will be available only if you have set your 
Practice Preferences (see page 25) , to collect taxes. The program will calculate the tax amount for you based on these 
settings when you click the fill field button (     ) to the left of the tax amount. This button and the tax fields are gray and 
disabled on the example screens because the practice we are using for the examples is not set up to collect taxes. 

User-Defined Adjustments 
Below the tax is a list where you can add user-defined adjustments to the service. Common adjustments such as a 
patient discount and insurance contract write-offs are entered elsewhere. Use this list if you have a special case 
adjustment that doesn't fit on one of the payer screens.  

Add an adjustment by clicking the Insert button (     ) and you will get the Adjustment to Charge screen on the next 
page. Enter the amount of the adjustment and select whether the amount increases the net charge or decreases it. In 
almost all cases and in the example screen, adjustments decrease the effective charge amount. That selection forces 
the adjustment to be a negative amount. If Increase charge amount had been selected, the amount would be a positive 
amount instead. 
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You can enter a comment that will appear on patient statements 
and an adjustment note that appears only on this screen. 

The first field below the adjustment list shows the total of all of the 
user-defined adjustments. The Payer Adjust

If this patient is exempt from a copayment on this service, check 
the 

 field shows the total 
of all the payer-specific adjustments (discounts and write-offs) that 
are described below. 

Exempt from copayment

Patient Payer 

 check box. This setting is used only 
on X12 electronic claims and nowhere else in the program. 

When you select the patient or a responsible party on the payer list in 
the upper right part of the tab, you will see the part of the screen 
shown here. Again, the tax fields are gray and disabled on the 
example screens because the practice we are using for the examples 
is not set up to collect taxes. 

If you ignore the tax fields, there are only two fields for patient and 
responsible party payers where you can enter or change something. 

Payer Fee Due 

This is the amount of the total that you expect to (hope to?) get 
from the selected payer. This is the amount before the discount but 
after the user-defined adjustments have been subtracted from the 
service fee. 

Payer Tax Due 

If you have to collect taxes on your services, this is the amount of 
tax you must collect from this payer. The Fill Field button (     ) will 
calculate the tax based on the Payer Fee Due amount. If you hold down the Ctrl

Payer Discount 

 key when you click this button, it will force the tax fee  due to the 
tax fee paid, usually zero. 

If you are discounting the fee for a particular patient or responsible party, enter the discount amount here. In the sample screen, the total charged 
the patient is $20, there a $5 discount, and nothing has yet been paid so the balance due from this payer is $15. 
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Move all balances to this payer 

Click this button to move all fees due from all payers to this payer. It will not move the portions of those fees that have already been paid or those 
adjusted off through discounts or write-offs. 

Quick payment from this payer 

Quick payments are usually payments collected at the time of service but you can use them however you want. You can only do a quick payment 
from a patient or responsible party payer. See Quick Payments on page 96 for more information. 

Claims Sent to Current Payer 

Because we're talking about patient and responsible party payers, this list is disabled. Claims are sent only to insurance payers. 

Current Payer's Payments 

This list shows all payments from the currently selected payer applied to this service. In the example, we are adding a new service so there are no 
payments yet. 

Insurance Payer 
When you select an insurance payer, the collection of fields in the box 
in the center of the screen changes to what you see on the right. 

Payer Fee Due 

Enter the amount due from this payer. You can also use the Fill Field 
button (     ) to fill this field from everything not already assigned to 
other payers. 

Payer Tax Due 

If you have to collect taxes on your services, this is the amount of 
tax you must collect from this payer. The Fill Field button (     ) will 
calculate the tax based on the Payer Fee Due amount. If you hold 
down the Ctrl

Payer Fee Paid / Payer Tax Paid 

 key when you click this button, it will force the tax fee  
due to the tax fee paid, usually zero. 

These two amounts are display-only fields and show what has been 
paid toward the fee and toward tax. 

Tax Loss Write-off 

Sometimes a jurisdiction requires taxes be collected but the insurance carrier will not pay the tax. Somebody's got to pay it so you have the choice 
of making the patient pay the tax or paying it yourself. If you pay it yourself, the Tax Loss Write-off is where you enter the amount you will pay 
yourself. The fill field button (you know what it looks like by now, right?) or pressing F2 will move the tax due amount to the tax write-off. 
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Contract Write-off 

When you are a "preferred provider" with a carrier, it usually means that you will accept what they choose to pay and agree to charge the patient 
only their copayment amount. That means you give up on collecting your full fee for service. If you start with the full fee, subtract the patient 
copayment and the amount the carrier will pay and what you are left with is usually your contract write-off. 

Clicking the Fill Field button will move whatever balance remains for the payer into the Contract Write-Off field. Holding the Ctrl

Risk-Pool Write-off 

 key down while 
you do this makes the write-ff zero. 

In order to keep costs down, managed care companies have developed the concept of sharing risk with providers. In other words, if you are in this 
situation, you are not only the provider of the services but the insurer for a portion of the total. The carrier withholds a percentage of their 
payment and places it into a risk pool escrow account. If, at the end of the year, the carrier makes is a profit and if you were “efficient” in your 
treatments, the carrier may, if they feel like it, pay you back some or all of what was withheld. 

Use this field to enter the risk pool amount withheld from the carrier’s payment. The Fill Field button calculates the amount based on the Risk Pool 
settings in the carrier record. 

Apply to Deductible 

If a carrier payment is lower (or zero) due to the requirements to first fulfill a patient’s deductible, enter here the amount that was applied to the 
deductible. When you enter an amount here, the program will use the division of responsibility rules you set up to add the amount of the 
deductible to the patient and/or responsible party amounts due. 

Bill Insurance / Amount 

Check this box of this service should be included on claims to the selected insurance carrier. If the box is checked, you should enter the fee amount 
you want to appear on those claims. 

Allow rebilling on batch claims 

Sometimes you need to rebill a service to a payer in a batch of claims. Ordinarily, when The THERAPIST generates a claim, it looks to see if a service 
has already been billed to a payer and skips that service on a claim if was already billed. Checking this box overrides this behavior so that it treats 
the services as not having already been billed so it will appear on a claim again. When a service with this box checked appears on a claim, the 
program will uncheck the box. 

Insurance Authorization 

Use this drop-list to select the authorization the service will be billed under on claims. You can also choose [No Authorization] if necessary. 

Claims Sent to Current Payer 
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This list would show all claims to this payer that included this 
service. Because we are adding a new service, no claims have 
yet been generated. Later, after generating one or more 
claims, you can go back to this screen and click the Change 
button (     ) below the claim list (it will be green if there are 
any claims) and you will be able to edit the EOB Date and 
Units Paid

Claim adjustment reason codes can apply to two different 
levels of the claim. At the higher level, they apply to the 
entire claim and not to any specific service. These higher 
level codes can be entered from the patient list by selecting 

 for that claim. This is also where you would add 
claim adjustment reason codes. These codes are reported 
when generating claims to other payers so they know what 
the first payer did. 

Generated Claims from the command bar (see page 53). 

The lower level codes are the ones we are describing here 
and apply only to the service we are looking at. 

You can also get to codes at both levels from the menus by 
going to Billing » Review Claim Batches

Claim Group Codes and Claim Adjustment Reason Codes, if any, are usually provided to you on your EOB 
though they may be on some other document or on a web page. The Group and Reason codes should 
come in pairs or listed as multiple reason codes for a group. Both codes are required in The THERAPIST. 

. Highlight the claim 
date on the left then expand the provider and carrier to see 
the claims which will be labeled by Claim Number. Editing 
this record lets you access the claim level codes. Expanding 
the claim will let you see the dates of service. Edit one of 
these to see the service level codes on the same screen as shown here. 

In addition to the codes, you can enter adjustment amount and quantity. These too should be part of the 
EOB or however you receive this information. 

Current Payer's Payments 

This list shows all payments from the currently selected payer applied to this service. In the example, we 
are adding a new service so there are no payments yet. There is no editing or drilling deeper here to see 
more payment detail on the list. 
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Links Tab 
Most offices seldom, if ever, need to go to this tab or change anything on it. Still, a brief description should be worth your time to read. 

On this tab, you can select various records to be linked to this service. To the right of the drop-lists, the Office, Facility and the two Physician

Current Case 

 
selections also have an Edit List (     ) button you can use to maintain the respective lists. 

The most important link on this tab is the link to the patient's Case record. If you have not purchased the Case Manager add-on, there will be only 
one case per patient and this selection is disabled. 

Office Name 

If you want to associate this service to a particular office, select it here. 

Override the default treatment facility for this service only 

For exceptional circumstances where treatment occurs outside of the normal setting, you can force this service to reference a different facility. 
Check the box and select a facility from the list. If the facility is not listed, you can use the Edit List (     ) button to add a new facility to the list. 

Ordering Provider 

This is not the referring provider. A referring physician is a physician who requests an item or service for the beneficiary for which payment may be 
made. Ordering physicians is defined as a physician or when appropriate a non-physician practitioner who orders services for the patient. Examples 
of services that might be ordered include diagnostic laboratory tests, clinical laboratory tests, durable medical equipment and services incident to 
that physician’s or non-physician practitioner’s service. 

Purchased Service Provider 

When this service is one you purchased from a third party, for example, an Independent laboratory, select the provider of the service here. For 
Medicare services at least, you cannot mark up the cost of the service. 

This service should update the counts and/or amounts in related authorizations 

In almost all cases, this box should be checked. Uncheck it only if it something special that was not authorized or should not be counted toward the 
amounts used on an authorization. 

Manage claim attachments to this service (     ) 

There are four kinds of X12 claim attachments: 

• Ambulance Certification 
• Chiropractic Certification 
• Paperwork 
• Claim Notes 

These can be attached to claims at the claim level, covering all services in a claim, or attached to specific services. This button takes you to a list 
where you can add any of the above attachments that will be included for this service only on X12 claims. 



Adding Services  Page 79 

PQRS Measurement Codes for this service (     ) 

If you are participating in the Physician Quality Reporting System (PQRS), you can enter the necessary quality measurement codes here. They are 
included on claims as additional service line items. If you are using CMS-1500 claims, either printed or electronic, you are limited to only five PQRS 
codes per claim because the service itself will be on line 1 of box 24 and the other five lines are used for the PQRS codes the codes will not wrap to 
a subsequent page. 

Categories Tab 
Categories are a way for you to categorize services in arbitrary ways. There are no built-in categories, you must define your own if you want to use 
them. The list on the left shows the categories you have added. The list on the right shows the choices you have defined for the category selected on 
the left. Each category also has a [No item selected] option at the top. You can select one item for each category.  

The Add or change the list of categories and selections

See 

 button (     ) will take you to the screen to add, delete, or modify your categories. 

Patient and Service Categories on page 118 for information on maintaining your list of categories and their selections. 

User-Defined Tab 
See the chapter on User-Defined Fields on page 119. 

Notes Tab 

General Notes 
The top part of the Notes tab is for 
general notes concerning this service. 
These notes are NOT progress notes but 
are either chart notes or private notes. 
Private notes are just that, private. They 
do not print on any report or statement 
nor are they included in any claim format. 

Chart notes, on the other had will be printed on the Chart Notes report that you can get to from the menu:  Reports » Patient » Chart Notes

The text of whichever note is highlighted will be displayed in the box on the right. It is not editable here, it is only for viewing. 

. 

Select a note to show on the transaction list (     ). 

The transaction list can also display a note for the selected transaction. If you want one of the notes above to be visible for this service, highlight it 
and click this button. It will be marked with the star icon and will show on the transaction list. 
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The icons on the left side tell you about the note selections: 

Selected for display 

Note is locked 

Chart note 

Private note 

When you add a general note to the list, you will see the Service Note screen on 
the right. This screen is simple and it's fairly obvious what the choices are. 
However, the Locked

Chart notes will be printed in the Chart Note report which you can access from the menu:  

 check box merits a bit of explanation. When a record is 
locked, it can be edited only by the user who entered it or by someone with 
administrator level security. You can lock both chart notes and private notes. 

Reports » Patient » Chart Notes

Progress Notes 

. Private Notes don't appear 
on any report, statement, or claim. 

Progress notes are the official progress 
notes attached to this service. Usually there 
will be only one progress note for a service 
but you are not limited to one. They will be 
listed by the date they are written and the 
note itself is shown in the larger box on the 
right. 

There are two columns for icons, the first 
shows the completion status and the 
second shows whether the note can be 
printed. 

Completed 

In-process 

Locked 

May be printed 

You can also enter progress notes directly from the patient list by clicking Progress Notes

For detailed information about progress notes, see 

 on the right side command bar. 

Progress Notes on page 99. 
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21. Memorized Services 
Memorized services are templates that are used to create new services. They allow you to store specific settings and codes that you use over and 
over. A memorized service consists of a header and a "bundle" of one or more service details. This lets you have a template that will create several 
services all at once. This is useful if your typically do several procedures in one session. Chiropractors and physical therapists in particular find this 
helpful. 

 

 

There are two kinds of memorized services: patient memorized services and system memorized services. Patient memorized services store more 
information because they know who the patient is and also what case and authorization is current. They also know about insurance and responsible 
parties so they can store the breakdown of what each payer owes and what discounts and write-offs you have applied. 

System memorized services are available to be used for any patient. Because of this, there is no patient attached to a system memorized service and 
therefore no responsible parties or insurance payers. With no payer information, they can't store amounts due from specific payers and any discounts 
or write-offs applied to those payers. System memorized services are best used for initial interviews where you don't know much about the patient 
beforehand. 

Memorizing a Service 
When you click the Memorize this service

The next two options are for adding another procedure to an existing memorized 
service. Again it can be for either a patient or system memorized service. If one or 
both of these selections are disabled, it means there is no memorized service of 
that type to append the procedure to. 

 (     ) button at the very bottom of a 
service entry form, you will be presented with the options screen shown here on 
the right. There are four options to choose from. The first two create new 
memorized services, either patient or system. 

If you select one of the choices to add a service to an existing memorized service, 
you then must select the service you want to append to. 

Once you have made all of your selections, click the Ok (     ) button to continue. 
The service will be added and you will be taken to the service entry screen when 

IMPORTANT Diagnosis code selections are not part of memorized services. Instead, they are selections 
you make in the patient's diagnosis. Each diagnosis code in the patient's diagnosis has a 
check box. When check, the corresponding diagnosis code will be checked in new services. 
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you can modify the values and settings as needed. If you had selected a memorized service with multiple procedures, the service screen will open for 
only one of them. You will have to open the others yourself if you need to change them. 

NOTE User-defined adjustments are not memorized because they are almost always unique to that 
service. However, the standard patient and responsible party discounts and the insurance tax-
loss, contract, and risk pool write-offs are memorized and should be used as needed. 

Editing a Memorized Service 
From a patient's transaction list, click Memorized Services (     ) option on the 
right side command bar. This will open the screen on the left where you can 
add, change, and delete memorized services. What you will see are the named 
memorized service headers along with the number of services in the bundle. 
Each header contains a bundle of one or more procedures. The tabs at the top 
let you choose either patient memorized services or system memorized 
services. 

Adding or editing a header opens the screen on the right. The header or 
bundle name is shown at the top. You can name this anything you want. 
It is used only to identify the bundle so you can select the right one 
when needed. 

The list part of the screen contains the procedures that are included in 
the bundle. There may be more than one but there must be at least one 
procedure listed. As you can see in the sample screen, when there is but 
one service, the delete button is not available. 

When editing a patient memorized service, it's pretty much the same as 
editing a service except there are not as many things to enter. For 
system memorized services, there are even fewer things you can access. 
Read the section titled Adding Services on page 69. 
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Adding a Service From a Memorized Service 
From a patient's transaction list, click the Add Service from Memorized (     ) 
option on the right size command bar. You will then be presented with the 
selection screen on the right. Use the tabs at the top to choose between 
patient memorized services and system memorized services. Highlight the 
one you want to use and click the select button that we have subtly 
indicated on the sample screen. 

Once you have mare your selection, the new service will be added and the 
entries and selections from the memorized service will be filled and selected 
on your new service. 

If you selected a system memorized service as the template for your new 
service, the amounts due from the various payers, will be determined just as 
if you were adding a service without using a memorized service. 

Diagnosis code selections are not part of memorized services. So whether 
you are using a memorized service or not, these selections come from the 
choices you have made on the patient's diagnosis. See the section titled 
Patient Diagnosis on page 60 for more information. 
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22. Payments 
You can enter payments from either the patient list or the patient's transaction list. Entering payments from the patient list is handy if you won't be 
entering or modifying any other transactions for the patient. Otherwise, it may be quicker to do everything from the transaction list. 

To enter a payment from the patient list, click either Add Insurance Payment (     ) or Add Patient Payment

Payment Wizard 

 (     ) on the right side command bar of the 
patient list. To enter a payment from the transaction list, open that list then click one of the same named items on the right side command bar of the 
transaction list. In either case, it will start the Payment Wizard. 

Whether you are entering an insurance payment or a payment from the patient or a responsible party, the steps are pretty much the same. The first 
wizard screen is simply some initial instructions. Once you are familiar with the process, you can check the box at the bottom to not show the 
instructions in the future. Hiding these instructions affects only the currently logged-in user, not all users. 

TIP: If you disable these instructions, you can always get them back in either of two ways. You can hold down the Ctrl 
key when starting the payment wizard or you can start the wizard by clicking with the Right Mouse Button

Each of the wizard screens includes some instructions at the top but we won't waste space here to show the instructions, just the entries and 
selections you need to pay attention to. Click the Next button to go on. 

. Either 
of these will bring the instructions back one time but you can uncheck the box to disable them in the future. 

Payment Date and Payer Name 

Payment Date 

What you mean by the payment date is up to you. It could 
be the date of a check or the date you actually receive it. The 
date defaults to the program's Working Date which you can 
set by going to Tools » Working Date

Select Payer 

. 

If this is a patient payment, this drop-list will show the patient and all active responsible parties. For insurance payments, it will show all of the 
patient insurances that are active as of the payment date. 

Payer Name 

Ordinarily, this is going to be the same name as shown in the Select Payer drop-list above. However, it is conceivable that you would want the 
payment name to show something different than the payer name from the drop-list. 
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Payment Information 

Total Payment Amount 

This is the total amount received on the payment. If this is a 
multi-patient payment, it is not the amount the amount for 
only the current patient. 

Payment applies only to the patient below 

Check this box if the entire payment will be applied to the 
current patient and there are no other patients included on the payment. 

First Patient Amount 

On multi-patient payments, enter the amount that will be applied to the current patient's account. It includes the total amount that will be applied 
to all services for this patient. For single-patient payments, it will always be the same as the Total Payment Amount above. If you are working from 
an EOB that does not give you patient totals, you can use the built-in calculator to add the individual service amounts. Go to Tools » Calculator or 
click the Calculator

Payment Method 

 button (     ) on the tool bar. 

Select the method of payment. This selection will determine which screen you will see when you click the Next button: 

Cash The next screen will be the Payment Notes screen. 

Check The next screen will be the Check Number screen. 

Credit Card If online credit card payment processing is enabled, the next screen will be the Credit Card screen, 
otherwise it will be the Payment Notes screen. 

Direct Deposit The next screen will be the Tracking Number screen. 

Check Number 

If you selected Check as your Payment Method

Credit Card 

, you will see the screen where you can enter a check number. The entry is optional but useful and it 
accepts numbers as well as letters and other symbols. 

If you selected Credit Card as your Payment Method

30

 and 
have enabled online credit card payments through Singular 
Payments, you will see this screen. You can enable credit 
card processing by going to the Practice Preferences. (See 
page ). 
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Process this credit card payment online… 

Check this box to process the payment online immediately after the wizard finishes. If you do, it will take you to a secure web site where you can 
enter all the necessary information. 

Card Holder 

Enter the card-holder's name. It should be the same as what appears on the credit card. The green Fill-Field button will fill in the payer name. 

Send payment email notification to the card holder 

You can have a payment notification email sent to the payer (or anyone else you desire) by checking this box and entering a valid email address. 

Email Address 

Enter a complete and valid email address here. They will receive a notice that their card was charged. 

Tracking Number (Direct Deposit) 

If you selected Direct Deposit as your Payment Method

Payment Note 

, you will see a screen where you can enter a tracking number. Your payer may call it 
something else but it is used for you to track that the payment was, indeed, deposited into your bank account. 

You will see this screen after you have completed whatever screen that came up based on the Payment Method

A payment note is optional and to enable the note field, use the 

 you selected. If you chose a Cash 
payment or a Credit Card payment and you have not set up to process cards online, you will see this screen immediately after the Payment 
Information screen. 

Space Bar key or the mouse to check the Enter a note for this payment

Select Patients 

 check box. 

You will see this screen only if this is a multi-patient payment. 

The list shows the patients with services that are paid by this 
payment. The second column is the amount of the payment 
that is applied to that patient's account. It is the total amount 
paid for all services for that patient. 

The Balance

When you add a new patient to the list, there are several options for you to choose. 

 amount is the about of the payment total that 
has not yet been applied to patient accounts. Use the Insert 
button (     ) to add payments to the list until the balance is zero. The sample screen above shows a $20 multi-patient payment with $10 going to 
Calvin's account and a $10 balance. You cannot go on until the balance is zero. Use the buttons to add, change, or delete patients. When you do, you 
will see the following Payment Patient Account screen. 
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Provider 

Select the provider who will be credited with the 
income from this patient's portion of the payment. If 
you apply the payment to services from a different 
provider, those amounts will be attributed to the 
other provider's income. 

Select Payer 

Select which of this patient's payers to use. This will 
be either the patient, a responsible party, or 
insurance depending on the payment type. 

Patient Amount 

Enter the amount to be applied to this patient's 
account. It will be the total amount to be paid 
toward all services for this patient. If you are working 
from an EOB that does not give you patient totals, 
you can use the built-in calculator to add the individual service amounts. Go to Tools » Calculator or click the Calculator

Statement Comments 

 button (     ) on the tool bar. 

This is an optional comment to appear on statements. 

Payment Note 

This optional note is attached to this patient's part of the payment so it is specific to this patient's account. It is not included in reports and is solely 
for your information. 

Lock Note 

Check this box if you want to lock the above note so that other users cannot change it. 

Finish 

The final wizard screen is basically just more instructions. When you click the Finish

The next section describes the process of applying the prepayments that were just added or those that were added previously. 

 button a prepayment record will be added to each selected 
patient's account. That actually completes the wizard and you can stop at this point if you wish. The program will assume you want to go on and 
apply the prepayments to services so it immediately takes you to the Services To Be Paid screen. It starts with the primary patient for whom you 
entered the payment. When you finished the first patient (perhaps the only patient), you can cancel or go on to the next patient. 
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Applying Prepayments 
If you are applying a payment to services or starting balances as part of entering the payment, you should already be at the Services To Be Paid 
screen. If you want to apply a prepayment after the fact, highlight a prepayment on the patient's transaction list. 

You can either double-click

This screen has a lot going on so it's a 
good idea to go over it in some detail. 
In the caption at the very top of the 
screen you see the screen title with 
the patient's name in square brackets. 
It helps to know which patient you are 
working with. Below that it show the 
name of the payer as you entered it 
when the payment itself was added. 

 the 
prepayment or highlight it and click 
Apply Prepayment on the right-side 
command bar. In either case, it will 
open the Services To Be Paid screen. 

The list at the top shows all of the 
active services and starting balances, 
those with a non-zero balance. The 
Total Charge column is the total fee 
for service and the Original Bal. 
column shows the balance before 
applying this payment. 

TIP: There are three ways you can tell which payments are prepayments or overpayments: 

• They have a bright dollar sign icon on the left; yellow for patient prepayments (    ) and purple for 
insurance prepayments (    ). Fully applied payments have a dollar sign icon that is more pale in color. 

• The balance will be anything other than zero. 

• There will be a small square icon in the far right of the line. A green square (    ) indicates a prepayment 
and a red square (    ) tells you it's an overpayment waiting to be refunded. 
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The Adjustments column shows the total of all of the adjustments on the service. This includes all discounts and write-offs as well as any 
adjustments that are not payer-specific. The Others Paid column shows how much was paid previously on this service. the tool-tip for the Others 
Paid column breaks the total down into the amounts paid by other payers and this payment's payer. 

The Paying Now column will show you how much of the current payment you are applying to the service now and the New Balance shows what 
remains after this payment and all previous payments and adjustments. 

Total Payment 

This is the total for the entire payment including any amounts applied to other patient accounts. This cannot be edited. 

Patient Amount 

This is the amount of the total payment that is applied to this patient's account. This cannot be edited. 

Adjustments 

This shows the total adjustments applied to this payment. 

NOTE: This adjustment amount is for adjustments applied to the payment, not to the service. 
Payment adjustments are for refunds, bounced checks, credit card charge-backs, etc. 

Apply to Services 

This cannot be edited directly, only by changing what you apply to services. 

Applied to Interest 

The amount of the payment that will be applied to interest. Interest charges are always paid first when it is a patient or responsible party payment. 
Insurance doesn't pay interest so don't even ask. They will laugh at you. This cannot be edited so if you don't want to pay interest you have to 
delete or write-off the interest charges before making the payment. 

Prepayment 

Enter here the amount you want to remain as a prepayment or overpayment after applying this payment to services. 

Unapplied Balance 

The Patient Amount shown above must be put somewhere and there are three places to put it:  applied to services, adjusted off, or applied to the 
prepayment or overpayment balance. The Unapplied Balance shows you how much you still need to deal with. You won't be able to complete this 
screen until the Unapplied Balance is zero. 

Provider 

Select the provider who will be credited with the income on prepayment or overpayment balances. If the full amount is applied to services, this 
doesn't really do anything. 
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Comments 

Enter any comments you want to appear on patient statements along with this payment. If you entered statement comments when you were 
adding the payment, they will show up here and you can change them if necessary. 

Prepayment Type 

When there is a balance remaining on a payment, it is marked as either a prepayment or an overpayment. There is really no difference between 
the two except that the expectation is that overpayments (    ) will be refunded while prepayments (    ) will be applied to charges. 

Apply Payment to Charge 

Click this button to apply some or all of the current payment to the highlighted service or starting balance. You can accomplish the same thing by 
double-clicking the highlighted service. The process is described below under Applying Payments to Services 

Though there

Applying a Patient Payment to a Service

 is a lot of similarity between patient versus insurance payments, there are differences so the screens are different and we'll discuss 
them separately. 

 on page 91. 

Auto Apply Payment 

You can apply the prepayment to each service yourself or you can let The THERAPIST do it for you. Auto-apply works well for most patient 
payments but, for insurance payments, most folks want the greater control you get by doing it yourself. That's because insurance makes their 
payments to specific services and it can come back to bite you later if you don't apply your payments the way they were intended. 

When you click this button you will be taken to the screen on the right. 
The Original Amount is exactly the same as the Unapplied Balance at the 
moment you click the Auto Apply Payment button. This same amount is 
copied to the Amount Available

For insurance payments, might be applying the payment to services that 
have appeared on an insurance claim. You can check the 

 and this is the amount you intend to 
automatically apply to services. You can change this though there is 
seldom a good reason to do so. 

Add EOB 
information…

Sometimes, the entire amount cannot be applied to services. The 

 check box to flag the record of these claims that an EOB 
has been received. This should almost always be checked on insurance 
payments. 

Save as a prepayment if the entire amount available cannot be applied check 
box determines what happens with the balance. Unless you have a very specific reason to not save it as a prepayment (or overpayment), this check 
box should always be checked. 
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Edit Selected Service 

You may have to edit a service if you need to re-arrange how amounts owed are distributed to different payers or if you want to enter adjustments 
that are not payer-specific. Payer-specific adjustments are discounts and write-offs and you can either enter them by editing the service or when 
you apply a payment to a service. 

Delete Payment to Service 

Use this button if you need to remove the portion of this payment that has been applied to the highlighted service. 

Applying Payments to Services 
Though there is a lot of similarity between patient versus insurance payments, there are differences so the screens are different and we'll discuss 
them separately. 

Applying a Patient Payment to a Service 
There are three tabs on this window but you will seldom need to even 
look at anything but the General tab. 

General Tab 
The Service Date, Procedure Code, and Service Provider fields at the 
top are just for your information. For instance, the Procedure Code

Payment Provider 

  
field in the sample screen on the right shows that we are applying the 
payment to a starting balance. Several other fields are also for your 
information and are not editable on this screen. These fields have a 
gray background. Fields that are all gray are disabled, usually because 
they don't apply at the moment. 

This is the provider who will receive the income based on this 
payment. It also determines which provider will receive payroll 
based on this payment. 

Date Applied 

Indicate here the date you want to use as the date the payment was 
applied to the service. This will affect when the income will be 
attributed to the provider. It also affects the payroll period if your 
payroll is based on payments. 
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Fee Amount Applied 

This is the field with the blue background in the row titled Fee Amount but in the far right column with a column title Amount Applied. This is a 
required field and is the amount you want to apply toward the fee for service for this payer. 

Tax Amount Applied 

This is the field in the row titled Tax Amount but in the far right column with a column title Amount Applied. It is the amount of tax you want to 
pay on this service. 

Discount 

If you are giving the patient or responsible part a discount applied specifically to them, enter it here. This discount does not directly affect any 
other payers though it does indirectly because it lowers the overall amount due on the service. 

Include this payment in CMS-1500 Claim Totals 

The total amount paid is reported in box 29 of the CMS-1500, when the service is subsequently billed to another payer, usually a secondary payer. 
Your choices are: 

Always Always include this amount in box 29. 

Never Never include this amount in box 29. 

Use Carrier Setting Use the Carrier setting for this choice. There are three separate carrier options for 
what payments to include in box 29 totals:  this carrier's payments, other carrier's 
payments, and patient (or responsible party) payments. 

All Payers Tab 
This is an informational tab where you can see a list of all payers toward this 
service and what the fee and tax due amounts are. You can also get more 
detailed information on each payer. The two screens on the right show the 
details for a patient (or responsible party) payer and an insurance payer. 

None of the fields on these screens are editable. They are here solely for 
your information to help you apply the payment appropriately. 

Notes Tab 
This is simply a large text note that will be attached to the portion of the 
payment applied to the service. 
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Applying an Insurance Payment to a Service 
There are three tabs on this window but you will seldom need to even 
look at anything but the General tab. 

General Tab 
The Service Date, Procedure Code, and Service Provider

Payment Provider 

 fields at the 
top are just for your information. Several other fields are also for your 
information and are not editable on this screen. These fields have a 
gray background. Fields that are all gray are disabled, usually because 
they don't apply at the moment. 

This is the provider who will receive the income based on this 
payment. It also determines which provider will receive payroll 
based on this payment. 

Date Applied 

Indicate here the date you want to use as the date the payment was 
applied to the service. This will affect when the income will be 
attributed to the provider. It also affects the payroll period if your 
payroll is based on payments. 

Fee Amount Applied 

This is the field with the blue background in the row titled Fee 
Amount but in the far right column with a column title Amount 
Applied. This is a required field and is the amount you want to apply 
toward the fee for service for this payer. 

Tax Amount Applied 

This is the field in the row titled Tax Amount but in the far right column with a column title Amount Applied. It is the amount of tax you want to 
pay on this service. 

Tax Loss Write-off 

Because not all payers will pay the tax charged on a service, you have to decide whether to pass it along to your patient or responsible party or 
whether you will pay the tax yourself. If you are going to pay the tax, enter the tax amount in this field. 

Contract Write-off 

This is for write-off that you are contractually bound to accept. This usually happens when you are in a payer's "panel" or if you are a preferred 
provider with this payer's health plan. 



Payments  Page 94 

Risk Pool Withhold 

This usually applies when you are sharing the "risk" of not making a profit from insurance premiums. What happens is that the payer will withhold 
a certain amount from their payments to you and at the end of the year, if you have been a good little provider and followed all their rules, they 
just might give you some of what they withheld. Yeah, right! 

Applied to Deductible 

When some or all of your charges are applied to the patient's deductible, enter that amount here. You can then charge the patient for it. 

Include this payment in CMS-1500 Claim Totals 

The total amount paid is reported in box 29 of the CMS-1500, when the service is subsequently billed to another payer, usually a secondary payer. 
Your choices are: 

Always Always include this amount in box 29. 

Never Never include this amount in box 29. 

Use Carrier Setting Use the Carrier setting for this choice. There are three separate carrier options for what payments to include in box 29 
totals:  this carrier's payments, other carrier's payments, and patient (or responsible party) payments. 

All Payers Tab 
This is an informational tab where you can see a list of all payers toward this 
service and what the fee and tax due amounts are. You can also get more 
detailed information on each payer. The two screens on the right show the 
details for a patient (or responsible party) payer and an insurance payer. 

None of the fields on these screens are editable. They are here solely for 
your information to help you apply the payment appropriately. 

Notes Tab 
This is simply a large text note that will be attached to the portion of the 
payment applied to the service. 
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Using Payments As Starting Balances 
Sometimes, when moving to The THERAPIST from some other system, you will have patients that have a credit balance. In other words, you either 
owe them a refund or they have prepaid for services you haven't yet entered. 

There are really just two kinds of starting credit balance, those you need to refund and those you will apply to future charges. 

Refunds 
If you owe someone a refund when you start using The THERAPIST, save yourself some effort by issuing the refund then there is nothing you need to 
do about it in The THERAPIST. 

If you need a "paper trail" for the refunds, enter the credit balances as one or more overpayments. Then issue the refunds and add a refund 
adjustment to the overpayments you just entered. 

Prepayments 
Enter the starting balance as one or more prepayments, one for each payer and provider combination where there is a credit balance. For example, 
if provider Mike has $100 from the patient, enter a payment for $100 from the patient as the payer and Mike as the provider. Leave it as a 
prepayment until you have services to apply it to. 

Another example, if provider Samantha has $75 from Blue Cross prepayment (yeah, right, like insurance ever pays in advance) on account for a 
patient account, enter the payment from Blue Cross for provider Samantha and leave it as a prepayment to be applied later. 
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23. Quick Payments 
Quick payments are a simple and streamlined way to add a payment quickly. However, achieving this simplicity means that these payments are more 
limited. Here is what you give up by using quick payments: 

• Quick payments are limited to patient or responsible party payments. 

• Quick payments can be applied to only one patient's account. 

• Quick payments can be applied only to the current service. 

• Quick credit card payments cannot be processed directly online. 

On the Money tab for services, when a patient or responsible party payer is selected, there is a button labeled Quick payment from this payer

Payer Name 

 (     ) in 
the center of the screen. The text of this button turns red when a quick payment has been added. Click this button to add a quick payment. 

This is probably already filled in correctly but if you need to 
change it, now's the time to do it. 

Provider 

This is the provider who will receive the income based on 
this payment. It also determines which provider will receive 
payroll based on this payment. 

Date 

Fee Paid 

This is a required field and is the amount you want to apply 
toward the fee for service for this payer. 

Tax Paid 

This is the amount of tax you want to pay on this service. 

Payment Medium 

Quick payments are limited to Cash, Check, and Credit Card. 
You cannot process quick credit card payments online. If you 
want to process a credit card online, use a regular payment, 
not a quick payment. 

Check Number 

The check number is optional but useful especially when a patient asks about a payment they have made. 
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Claim Totals 

The total amount paid is reported in box 29 of the CMS-1500, when the service is billed to insurance. Your choices are: 

Always Always include this amount in box 29. 

Never Never include this amount in box 29. 

Use Carrier Setting Use the Carrier setting for this choice. There are three separate carrier options for what payments to include in box 29 
totals:  this carrier's payments, other carrier's payments, and patient (or responsible party) payments. 

Comment 

Enter any comments you want to appear on patient statements along with this payment. 

Note 

The note you enter here will be saved with the "base payment" part of the payment. 

Delete this quick payment 

This button will be present only if you have already added the quick payment. It lets you change your mind and delete the quick payment you just 
added. If you're a blonde and change your mind again, you can add it back. Okay, I admit it, I am a blonde, well, blonde-ish anyway. 
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24. Treatment Plans 
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25. Progress Notes 
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26. Therapy Groups 
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27. Insurance Claims Selection Rules 
The THERAPIST uses a single process to select patients and services to bill regardless of whether you are printing your claims or generating them as 
an electronic file. Therefore the rules for selection are consistent for all claims, whether printed or electronic. 

Different rules are used depending on whether you are selecting the patient and services yourself or you are doing batch claims for one or more 
providers. Some of the rules require that an insurance carrier being billed must be a carrier associated with an electronic claims receiver. All carriers 
are associated with either an electronic claims receiver record or to a special, hidden receiver used only for printed claims. Any carrier not associated 
with an actual electronic claims receiver is automatically associated with the special printed claims receiver. 

One Patient 
When you generate claims for a single patient, you select the patient, the insurance, and services yourself. The program makes no decisions on 
which of these to include in the claim. 

One Provider by Service Provider 
When you choose to select by service provider, service selection rules determine which patients are selected. 

Service Rules 
1. The service provider must be the selected provider. 

2. The date of service must be within the date range specified. 

3. The service must be set to bill to a carrier that is selected for the claim receiver. 

One Provider by Patient's Principal Provider or All Providers 
When you choose to select patients by the patient's principal provider, the following rules are used in the order shown. 

Provider Rules 
1. Even when only a single provider is selected, checking the box labeled "Include providers who are the same resource" will bill all "aliases" 

of the selected provider or providers. 
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2. A provider-carrier option lets you tell the program that services by a provider who has a specified supervisor should be billed as if the 
supervisor was the rendering provider and not the actual provider specified on the service. The actual provider of the service will still be 
used 

Patient Rules 
1. The patient must be active. 

2. The patient's principal provider must be the selected provider. 

Insurance Rules 
1. The insurance eligibility dates must indicate that the patient is covered for some or all of the selected claim date range. 

2. The patient's insurance must be selected for batch claims. 

3. The insurance carrier must be a carrier associated with the selected electronic claims receiver, if generating electronic claims, or the special 
hidden receiver for printed claims. 

4. The patient's principal provider must be selected to be billed to the insurance carrier. This is a provider-carrier option which is set in either 
the carrier options for the provider or the provider options for the carrier. 

5. If the provider-carrier option is set to use a supervisor as the rendering provider for a supervised provider, the supervising provider must be 
selected to be billed to the insurance carrier. 

Service Rules 
1. The service's "From" date must be in the selected date range. 

2. If the claim option excludes services with a zero balance, the service must have a non-zero balance. 

3. The service must list the selected patient insurance. 

4. The insurance option for this service must be flagged as billable. 

5. The insurance priority stored in the service insurance record must correspond to the priority selected in the claim options. 

6. If the claim option excludes services with an EOB date, there must not be an EOB date for the service from the insurance being billed. 

7. If the claim option excludes services that have already been billed, the service must not be marked as billed from a previous claim. 

8. The procedure code for the service must be flagged as billable. 

9. If the claim option excludes services that have been paid by this insurance, there must be no payments to this service from this insurance. 
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28. Electronic Claim Receivers 
The paths should be in the same location for all computers on a network. 

 

CMS-1500 Generator 
CMS-1500 Claims: +C+Y-+M-+D +H.+M.+S ###.cms 

 

X12 5010 Generator 

Receiver Options 
In 3.0, you can bill or rebill a single patient electronically the same way you can with printed claims. This makes it much easier to rebill selected 
services. Because it is so easy to do, you are more likely to end up creating multiple claim files on the same date. If your receiver option for the claim 
file name does not include an automatically incrementing number, you could easily overwrite a claim file by mistake. To ensure that this doesn't 
happen, the default claim file name uses replaceable tokens that guarantee that duplicates do not happen. However, if you imported your data from 
an earlier version, you may not have your claim file name set up to prevent accidental overwriting. To change the file name, go to: 

About half way down, look for the field named File Name. Somewhere in the name, add at least two consecutive hash (#) symbols. Three is better 
but four or more is usually excessive. Depending on which generator you are using, the default file name is one of these: 

Billing » Electronic Claim Receivers » Receiver Options » Generator tab 

X12 Claims: +C+Y-+M-+D +H.+M.+S ###.x12 

Generator Options 

Component Element Separators, sometimes referred to a Sub-Element Separators are used to separate elements that are part of a component or 
sub-element. 

Contact 

WARNING! Do not enter a contact name that is the same as organization or individual name entered above. Doing so 
is likely to cause your claims to be rejected. 
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29. Appointment Scheduler 

Appointment Calendar 
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Event Labels 

Event labels allow you to color-code each of 
your appointments according to the type of 
appointment or using any criteria you wish. 
There are four built-in labels each with its own 
initial default color. These are the default labels 
for appointments of the respective type but you 
can change it for any appointment. 

Setup » Lookup Lists » Appointment Labels 

You can edit the built-in system labels but your 
options are limited. The Label Name

If, in playing around to find a color you like, you give up and 
decide to use the default color, just click the 

 field is not 
changeable but to change the color, click where it says Click 
Here to Select Label Color. (Hey, give me a break; I guaranty 
that some people won’t figure that out!) 

Reset to default 
color

If you have need for more than the four system labels, you 
can add your own such as the Custom Color label shown in the 
example screens on the left. 

 button. 

When selecting a label color, you will get the standard 
Windows color selection screen shown on the right. It may 
look different in your version of Windows but it should work 
pretty much the same. 

The Standard Colors

The array in the 

 drop-list lets you pick from a list of things 
that Windows assigns colors to. This selects a color indirectly. 
You select the object and get whatever color that the current 

Windows theme assigns to that object. Themes are assigned via the Display Settings in the Control Panel. If you 
choose a different theme, you will more than likely get a different color. 

Basic Colors group is a limited palette of 48 colors. It is easy to use but, again, it is limited. Click a color to select it and then click the 
Ok button to accept that color selection. 
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But wait, there’s more! You can use the Define Custom Colors

There are three ways independent to specify your color: 

 button to 
expand the color selection screen so that you can define more colors. With 
this screen you can create 16,777,216 possible colors. 

1. You can use the mouse to position the two pointers circled in red in the 
screen on the right. Move the       over the big rainbow color box to pick 
a color and slide the  up and down to select the intensity (lightness or 
darkness) for the selected color. 

2. You can use the Hue (0-239), Saturation (0-240), and Luminance

3. Specify the individual color components:  

 (0-240) 
to specify a color if you either know the values you want or understand 
how they work together. 

Red (0-255), Green (0-255), 
and Blue

When you make a change using any of the three methods, you will see the 
others change correspondingly. By the way, the number of possible colors, 
16,777,216 is arrived at by multiplying the number of possibilities for each 
of the Red, Green, and Blue color components and adding 1 to account for 
zero (0, 0, 0), which is Black. White is represented by 255, 255, 255 values for these three components. 

 (0-255). 

You can start with one of the basic colors by selecting it then modify it using any of the methods above. Once you have the color you want in the 
Color|Solid box, just click Ok to select and use it. You don’t need to use the Add to Custom Colors

NOTE: Your custom colors are not saved permanently. They will go away when you close The THERAPIST. 

 button but you can to place your custom color in 
one of the Custom Colors boxes on the left. If you do click this button, whichever of the custom colors palette boxes is selected (like the top left rose 
Basic Color in the example screen above), that is the Custom Color that will be changed. If none of the Custom Colors is selected, the first one will be 
changed even if it is filled with a different custom color. 
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Exporting Appointment Reminders 
The THERAPIST has the ability to export a file containing appointment and contact information for upcoming appointments. This file can be uploaded 
to a service that will handle all of your patient appointment reminders. These services can make voice calls, cell phone text messages, and emails. 
You have the choice of methods and can be notified of the responses to the reminders. 

To make this process work requires some setup in The THERAPIST. 

1. In the Practice Preferences (Setup » Preferences » Practice Preferences

• The type of appointments that will be exported. There are four check boxes corresponding to the four possible appointment types. Select 
the appointment types you want to export. 

), go to the Scheduler tab. The bottom half of the screen, in the box labeled 
"Export Appointment Reminder File" has options that control the following settings: 

• Whether to include field titles as the first line exported. Field titles tell the system that receives the export file what data is in each 
column. Most services require field titles be included. 

•  Whether to include notes in the export. There are two types of notes that can be included in the export files. You can include or exclude 
the appointment note in the export. If your appointment notes have information that would be useful to making reminder calls and your 
service can use this information, check the box. Similarly, each phone number or email address that is exported has an optional short note. 
If these notes contain information necessary to contact the patient, consider including them in the export. 

• The date range (based on the number of days in the future) to export. To make the process as simple as possible, exporting a reminder 
file is a semi-automatic process. The Starting Days setting will be used to calculate the starting appointment date to be exported and the 
Ending Days is used to calculate the ending appointment date. Your service should have recommendations about how far in advance of 
appointments you should export and upload the file. 

• The name of the export file. Most services don't care what the file is named so the default file name includes the starting and ending dates 
so that you will know what was exported. The file name uses tokens that are used to customize the file name based on the starting and 
ending appointment dates. For example, if you export the date range 12/28/2013 to 1/5/2014, The tokens would be expanded as follows: 

 Start Date 
+C 

End Date 
20 Century +c 20 

+Y 13 Year +y 14 
+M 12 Month +m 01 
+D 28 Day +d 05 

Everything that is not one of the tokens will be used exactly as you enter it. 

NOTE: DO NOT enter the path or folder name. You will select the path when you do the export. The path 
you select will be saved so that you should only need to select it the first time you export. 
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2. In the patient information screen, on the Status tab, about half way down on the right is a check box labeled "Send appointment reminders". 
It should not come as a great shock that you should check this box if you want reminders sent for that patient. 

3. Also on the patient information screen, on the Phone & Email tab, check the Primary Contact check box for all phone numbers and email 
addresses that you want to include in the export file. In addition, on mobile phone numbers, check the box labeled "SMS text messages can 
be sent to this number" if you want to allow text message reminders. You may also have to indicate this preference directly to the reminder 
call service you are using. 

NOTE: The reminder export file can export one email address and up to eight phone numbers. 

Once all of your settings are in place, and assuming you have appointments to export, the export is done by going through the reports menu: 
Reports » Scheduler » Export Reminder List

• Export appointments that are already confirmed. Ordinarily, this should remain unchecked. 

. Here you will be able to confirm or change the export date range and set two more options: 

• Export appointments that have already been exported. When you do an export, the appointments are marked as having been exported. This is 
to prevent accidentally exporting appointments more than once. However, if there was a problem in creating the export, it is possible that the 
appointments were marked but you won't have a file to upload. This can also happen if you accidentally delete an export file. When either of 
these happens, you can recreate the export by checking this box and exporting the same range of appointment dates. 

Once you have set the options the way you want them, click the green check to export the file. You will be asked to confirm or select the location 
where the file will be placed. Once selected, the export process should complete with only a message at the end telling you how many records were 
exported. 
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30. Reports 
 

 

Mailing Labels 

USEFUL TIP! Before you print mailing labels for the first time or if you are changing to different label size or layout, start 
by printing a page of labels on plain paper. Because ordinary paper is a lot less expensive than label stock, 
you will save money by doing you initial testing on regular paper. Line up a sheet of labels with your test 
print on regular paper and hold it up to a light to see if your alignment is perfect or if it still needs some 
tweaking. 
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31. User-Modifiable Reports 

Dates 
Dates are stored as the number of days that have elapsed since December 28, 1800. Okay, that's a little weird but that's the way it is. To show a date 
field, it has to be formatted. If the date appears alone in a frame, you can set a "picture" on the frame that formats the date number into a readable 
date. The following date pictures are available: 

Picture Pattern Example  Picture Pattern Example 
@d1 mm/dd/yy 10/31/59  @d10 yyyy/mm/dd 1959/10/31 
@d01 mm/dd/yy 01/01/95  @d11 yymmdd 591031 
@d2 mm/dd/yyyy 10/31/1959  @d12 yyyymmdd 19591031 
@d3 mmm dd,yyyy OCT 31,1959  @d13 mm/yy 10/59 
@d4 mmmmmmmmm dd, yyyy October 31, 1959  @d14 mm/yyyy 10/1959 
@d5 dd/mm/yy 31/10/59  @d15 yy/mm 59/10 
@d6 dd/mm/yyyy 31/10/1959  @d16 yyyy/mm 1959/10 
@d7 dd mmm yy 31 OCT 59  @d17 Windows Control Panel Short Date 
@d8 dd mmm yyyy 31 OCT 1959  @d18 Windows Control Panel Long Date 
@d9 yy/mm/dd 59/10/31     

Alternate date separators 
@d1. mm.dd.yy Period 
@d2- mm-dd-yyyy Dash 
@d5_ dd mm yy Underscore produces space separator 
@d6` dd,mm,yyyy Grave accent produces comma separator 

Adding a B (or b) to the end of a date picture causes it to be blank when the date is empty. 

To use a date field in a calculated string, you must use the FORMAT command to format the date and concatenate or combine it with other parts of 
the string. For example the frame contains the following formula. 

= 'Patient birthday is ' & FORMAT(PAT:Birthdate, @d2) & '. Happy birthday!' 

If you don't use FORMAT, the resulting string will show raw date which is just a number so you would end up with something like: 

Patient birthday is 69223. Happy birthday! 

Unfortunately, birthdates before October have a single digit month so there would be an extra space after "Patient birthday is ". To overcome this, 
force the formatted birth date to be left-aligned as follows: 
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= 'Patient birthday is ' & LEFT(FORMAT(PAT:Birthdate, @d2)) & '. Happy birthday' 

Oops, now that extra space appears before the period. Here's how to eliminate the trailing space: 

= 'Patient birthday is ' & CLIP(LEFT(FORMAT(PAT:Birthdate, @d2))) & '. Happy birthday' 

NOTE: Functions such as FORMAT, CLIP, LEFT, and others are not case-sensitive so 
you can use format, clip, or left if you prefer. 

Displaying Logical Values and Selections 
CHOOSE(PAT:Employed, 'Yes', 'No') 

CHOOSE(PAT:PatientType, 'Single', 'Couple', 'Family', 'Organization') 
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32. Backup and Restore 

Backing Up Your Data 
There are several ways to back up your data. If you use The THERAPIST to make a backup, the backup is stored in a single compressed file and each 
backup, whether for the global data or the data for a practice, is stored in its own file. There are two types of backups you can make from within 
The THERAPIST: a Quick Backup and an Offline Backup. A third type, Automatic Backup, is really just a Quick Backup that happens automatically 
when you close The THERAPIST.  

Offline Backups differ from Quick Backups in that all of the Quick Backup options are set ahead of time in the Backup Options. So when you click the 
Quick Backup button or select a Quick Backup from the menu (File » Quick Backup

IMPORTANT! Don't rely only on Quick Backups. Backups stored on the same physical media as your data will become 
inaccessible if that media is unavailable. Even quick backups to a network drive should not be relied on 
totally because in the event of a disaster such as a fire or theft, you might lose both your original data and 
the backup. 

), the backup starts immediately thus earning their name. Quick 
backups are designed to store your data locally on your hard disk but you are not forced to set it up that way. You can choose any location that will 
be available at all times, including another location on your network. 

Offline backups, on the other hand, give you more choices and flexibility. They are also designed to backup your data to some external device so that 
if your computer becomes unusable, your data is safe. At this time, we recommend using flash drives (also known as thumb drives, USB drives, etc.) 
for offline backups. They are inexpensive, reliable, and even the smallest drives sold today have sufficient capacity to hold the data from even the 
largest practices. 

Restoring Data 
In a perfect world, you would never need to restore from a backup unless using it to move data from one computer to another. Unfortunately, this is 
not a perfect world. When the worst happens (and eventually it will) and something unfortunate happens to your computer or your data becomes 
corrupted, you will be very glad you made regular backups. 

There are several ways to back up your data and each requires its own way of restoring the data. If you made a backup from within The THERAPIST, 
the backup is stored in a single compressed file and each backup, whether for the global data or the data for a practice, is stored in its own file. 
These backups can be made to your local hard disk or to some external media. These are basically the same except that when you backup to your 
local hard disk (Quick backups and Automatic Backups), The THERAPIST knows where to find the backup to restore and when the backup is on some 
external media (Offline Backups), you have to go out and find it. 
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Some organizations don't use the built-in backup in The THERAPIST and instead rely on some kind of external backup process or program. If the 
external backup results in a copy of the data files in a folder structure paralleling The THERAPIST's data folders, you can restore the data by going to 
File » Restore Data » Restore Folder

Restoring an Offline Backup 

. You then select the folder where the global data is located or a folder where the data for one practice is backed 
up. If you select a global data folder, the program will restore the global data then ask if you would like to restore data for practices found in the 
subfolders. 

When you restore an offline backup, the you are instructed first to insert the last disk of the backup set. The last disk contains information about 
what is contained in the backup so the program needs it first. 

File » Restore Data » Restore Offline Backup 

Using the Windows standard file selection screen, you are then asked to select the backup file to restore. Highlight the file and press the Open

The number in parentheses is used internally by the program to identify the practice. It is also the name of the practice sub-folder. This is followed 
by the practice name. The file extension is .tpz. The THERAPIST creates PKZip compatible files for backups but uses a different file extension to avoid 
conflicts with zip file manager programs. 

 
button or simply double click the backup file name. The file name is something like Backup (86508015) Phoebe Dring.tpz. 

Finally, you are asked whether you really want to replace the current data from the backup. This is a safety precaution to protect you from 
accidentally writing over good data with old data. Once confirmed by typing YES, you are asked to insert the disk 1 of a multiple disk backup set. 

IMPORTANT! If you are restoring an old backup for the purposes of accessing the records of patients you have removed from 
the program, first make both a quick and offline backup of the current data or you could lose critical data. 

Restoring a Quick Backup or Automatic Backup 

Restoring a Quick Backup or an Automatic Backup is identical to restoring an offline backup with the sole exception of where the backup files are 
stored. Quick and Automatic Backups are stored together in the folder specified in the Backup Options. 

File » Restore Data » Restore Quick Backup 

Restoring from a Folder 

If the data you want to restore is not a backup made by The THERAPIST but is a data folder for The THERAPIST Pro 3.0, you can restore either a single 
practice by selecting the numbered practice folder (or whatever folder name has the practice data in it). You can also restore the entire collection of 
data including the global data and all practices by selecting a folder containing the global data and all of the practice data sub-folders. 

File » Restore Data » Restore From Folder 
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Backup Options 

Many, though not all, of the backup options affect 
only the computer where they are entered. If you 
go to this same screen you may see a completely 
different set of option settings. The fields that have 
blue prompts (the descriptive text for the field) are 
the options that affect only this computer. The ones 
with a normal (usually black) text are for the 
program on all computers running The THERAPIST. 

Setup » Preferences » Backup Options 

If you want your offline backups to be saved onto a 
CD or DVD, check the box labeled that way. It will 
force a different offline backup path, one that 
Windows uses as a staging area for burning files to a 
CD or DVD. The backup, when you make it, may not 
be written to the CD or DVD right away. It may wait 
until you try to remove the disc from the computer 
before it actually burns your backup to disc. This is 
ultimately controlled by Windows. 

In addition to the normal data files, there are other 
files stored in subfolders of the data folders holding 
data for your practice. These subfolders hold 
images, user-modifiable reports and other 
documents. The global data folder also has a 
subfolder for user-modifiable reports that may be 
used by all practices. Use the check box labeled Backup user-modifiable reports, images, and documents in offline backups

The backup reminder window is enabled by default. The only reason to turn it off is if your data is backed up outside of The THERAPIST. Even this is 
not a good reason because, if disaster strikes, it is a lot easier to restore your data if the backup was made by The THERAPIST. 

. There is an equivalent 
check box for quick backups. 

The backup password adds a level of security to your backups. However, it means that you have to know the backup password if you ever have to 
restore your data after a catastrophe. Beaver Creek Software has ways to recover your backup password if it becomes necessary. 
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Backup Strategies 
The importance of making regular backups of your data cannot be stressed strongly enough. When deciding on a backup strategy, ask yourself how 
much your data is worth. After all your livelihood depends on it and, if you have staff, so do theirs. 

Flash Drive Backup Strategy 
This strategy gives you the maximum protection with little effort. 

With availability of inexpensive, high capacity flash drives, there is 
really no excuse for not doing offline backups regularly. Flash drives 
are not only inexpensive, they are fast, convenient, and secure. They 
are the media of choice for making your offline backups. However, if 
you just backup to the same flash drive every time and overwrite the 
previous backup you are not getting the maximum safety and cost-
effectiveness from your drives or your backup strategy. 

As of the writing of this manual, the smallest size readily available is 
4 GB. That is over four billion characters of data you can store on 
each drive and you can pick them up at your local office supply store often for under five bucks each. Even the largest of backups from The 
THERAPIST is miniscule in comparison and gives you the opportunity to store multiple backups on each drive. 

This article will give you a very secure backup strategy using five flash drives. Starting with blank drives, you first want to create a series of 10 folders 
on each drive naming the folders with the numbers 1 through 10. 

Be sure to label each flash drive using permanent marker or a labeling machine tape. Label them Drive 1, Drive 2, etc. 

The backup schedule will have you make an offline backup of your global data and all practices each day you use The THERAPIST. It takes only a 
moment and can really save your hide if the worst every happens. 

Day 1 Backup to Drive 1 into folder 1 
Day 2 Backup to Drive 2 into folder 1 
Day 3 Backup to Drive 3 into folder 1 
Day 4 Backup to Drive 4 into folder 1 
Day 5 Backup to Drive 5 into folder 1 
Day 6 Backup to Drive 1 into folder 2 
Day 7 Backup to Drive 2 into folder 2 
Day 8 Backup to Drive 3 into folder 2 
etc. 

Start with backing up to folder 1 each day using Drive 1 on the first day, 
Drive 2 on the second day, etc. After backing up to drive 5 on the fifth day, 
go back to Drive 1 but backup to folder 2. Continue with the same pattern 
until you have backed up to Drive 5 into folder number 10. Then start over 
with Drive 1 into Folder 1, overwriting the backup in that folder. 

Once you have completed a full cycle, you will have 50 backups and can 
restore any of them should the need arise. 

WARNING! Never remove a flash drive from your computer unless the 
power is off or Windows tells you that it is safe. Windows 
has an icon in the system tray for safely removing hardware. 
Each version of Windows uses a different icon (thanks a lot 
Microsoft!) but here is one example:       The system tray is 
the cluster of icons, usually in the lower right corner of the 
screen, that also shows the system date and time. Click that 
icon and select the drive letter corresponding to your flash 
drive. After a few seconds Windows should respond that it is 
now safe to remove the drive. 
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For added safety, when you finish making a backup onto a flash drive, set it aside to take home. The next day, when you take that backup home, set 
aside the one you brought home yesterday and take it with you to the office. This way, you will always have one drive in a different location in case 
something terrible happens like an alien spaceship crashing into your office and destroying it. 

To help you keep track of the backups, you can print a form where you can write the date of each backup for the disk. It is best to print this onto card 
stock or heavy weight paper for durability because it will be handled frequently. You can find the form from inside the program by going to: 

Help » Other Documents » Flash Drive Backup Form (Or click here:  Flash Drive Backup Form.pdf) 

Cloud Storage Backup Strategy 
This strategy is best for those who don't want to think about backups. It uses an 
external cloud storage service to keep copies of your backups in a secure location on 
the Internet. 

All of the cloud storage solutions we have looked at (Microsoft One Drive, Google 
Drive, Dropbox, and Amazon Cloud Drive) create a folder somewhere on your 
computer and then run a small program in the background that monitors that folder. 
Any files you put there are automatically uploaded to your private storage on their 
servers. When a file is updated in that folder on your computer, it is updated on the 
cloud as well. Synchronization goes both ways so if you have a second computer, one 
at home for instance, you can connect to the same cloud storage service then the 
corresponding folder on the home computer will be updated automatically with 
whatever files you have stored on the primary computer. Again, it goes both ways so 
if you update the files on the home computer, the files on the primary computer will be updated as well. 

The way to set up The THERAPIST to use this is to use the local cloud storage folder as the target of your quick backups. You should probably create a 
subfolder in the cloud storage folder, called something like The THERAPIST Backups. Then, in the backup options, enter the complete path to that 
folder for the Quick Backup Path

Once that is done, all of your quick backups and automatic backups will be saved to that folder and automatically uploaded to your private cloud 
storage. In case you missed it, you can make a quick backup by clicking the 

. 

Quick Backup

If you are using a second computer, such as the home computer mentioned above, you can simply restore the last backup in your local cloud storage 
folder. From the menus, go to 

 button (      ) on the tool bar. 

File » Restore Backup » Restore Quick Backup

Why Not Put the Data Folder Directly in Cloud Storage? 

. 

This would be a monumentally bad idea for several reasons. The reasons are technical and not important to go into here. Just know that you 
shouldn't do it and if you do it anyway, you could incur lots of technical support charges both from us and from whoever you hire to fix it. 

Cloud storage services all say that your data will be 
protected and they really do a lot to make sure that 
happens. Unfortunately, almost every week we read 
about another company being hacked and important 
data stolen, from credit card information to medical 
records. You have to evaluate these variables yourself. 
Also, some cloud storage companies are willing to sign a 
HIPAA Business Associate Agreement and others are not. 
We will not tell you what service to use or which to 
avoid. It's your data, do your research. 
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33. Patient and Service Categories 
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34. User-Defined Fields 
Several of the major tables in The THERAPIST (Providers, Patients, Insurance, Carriers, 
etc.) have the capacity to accept fields that you define. These user-defined fields are 
on a tab with the descriptive but unimaginative label, User-Defined

The yellow background on the first user-defined field on the right tells you that the 
value ("Yes" in this case) has been changed from the value it had when the update 
form was opened. The colors in the second line simply indicate that this is the 
currently selected row. 

. 

To edit a field value, either double-click anywhere in the row or highlight the row and 
click the Change

To define fields, click the 

 (     ) button. 

Edit User-Defined Fields List button (     ) which opens the 
fields list below. This is where you can add new fields and delete ones you no longer 

need. Changing a field should be reserved for wording 
changes and fixing typos. Changing the meaning can 
be disastrous. 

WARNING! If you have any data entered 
anywhere for a particular user-
defined field, never change the 
definition of that field. You can 
change the name (though even that 
is not a good idea) but not what it 
stands for. Doing so would make all 
values for that field, wherever they 
occur, meaningless or worse. 

WARNING! It's seldom a good idea to delete 
fields when any data has been 
entered for that field. Instead of 
deleting it, make it inactive. This 
hides it but doesn't delete the data. 
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Adding and Editing User-Defined Fields 
Unlike providers, patients, 
carriers, etc. where the fields 
are, for the most part, pretty 
obvious in what they do, user-
defined fields is something 
very different so it's important 
to understand each entry. 

Name 

This is the name you will see 
on the field list. This includes 
not only the list for defining 
the fields but also on the list 
where you enter actual data. 

Field is Active 

When not checked, this field acts as if it wasn't here. You will see it only on the field definition list when the Show Inactives

Field ID 

 box is checked. 

This is generated automatically and you cannot change it. You will need it only if you use user-defined fields on user-modifiable reports. 

Description 

The description is used as the Tool Tip for the field on both the definition and data entry lists. 

Token Name 

In order to use data entered for this field on form letters, treatment plans, progress notes and other case-management records, it has to have a 
field token. You can enter your own token name and the program wraps it up into the actual token which you will see in the Complete Token line 
below the token name. 
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35. User Interface Settings 
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36. Rich Text Notes 
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37. Miscellaneous 

Spell Checking 
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38. Reinstalling The THERAPIST 
These instructions are designed for situations where you are reinstalling The THERAPIST on the same computer or are installing The THERAPIST on a 
second non-networked computer. There are five steps to the process: 

• making backups of your data 

• installing The THERAPIST 

• restoring the data 

• synchronizing the data 

• removing the program from your old computer 

Sometimes the last step is unnecessary or impossible to do. 

Backing Up Your Data 
Be sure to make backups of all of the data on your old computer. This includes the global data and each of your practices. Don't forget the global 
data. If there is a backup password on this computer, either make note of it or remove it before making the backups. You can see or remove the 
backup password by going to Setup » Preferences » Backup Options

Usually, the most convenient place to back up to is a USB flash drive. Sometimes called thumb drives, these handy devices are cheap, reliable, and 
easy to move to your new computer. 

. The password is in the lower right corner. 

Installing The THERAPIST 

NOTE: The THERAPIST is licensed to be installed on one computer. Installing the software on a second 
computer, unless it is a direct replacement, is not free. Contact customer service, if necessary, to 
purchase a second installation. 

1. Using your most recent installation CD or download, install The THERAPIST. You can contact Customer Service at 800-895-3344 to order a 
maintenance release, either on CD or as a download, of the most current version. 

2. Run The THERAPIST. The first thing you will see is a selection screen where you select which program to run. Your choices are The THERAPIST 
Pro, the Administrator Utility, or Support Information. Choose the Administrator Utility

3. If you did not install the most recent release of The THERAPIST, you can download an update from the Beaver Creek Software web site at 

. 

http://www.beaverlog.com/therapist/download/pro3update.exe. Don't skip this step or you may get errors after you restore your data. 

Use the following to login to the Administrator Utility: 

http://www.beaverlog.com/therapist/download/pro3update.exe�
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Login Name: ADMIN 
Password: ADMINPASS 

Restoring Data 
1. If your data was backed up from a computer with a backup password, you must use the same backup password to be able to restore it. If you 

don't know the password, you won't be able to restore your data. Enter the password by going to Backup and Restore » Backup Options

2. Restore your global data backup and each of your practice data backups by going to 

. 

Backup and Restore » Restore Offline Backup

Synchronizing the Data 

. Repeat this 
step for each backup you will be restoring. 

1. Close the Administrator. The THERAPIST main program will start automatically. You will probably get a message that a secondary installation 
was detected and can continue or enter a synchronization code. When you are at the code entry screen, call customer service at 800-895-3344 
Monday through Friday from 9:00am to 5:00pm Pacific Time to obtain your code. You must be at this screen because we need the Support ID 
from that screen to generate the code. 

2. If you are doing this after hours or on a weekend, you should be able to skip synchronization for ten days. 

3. Print a registration form from the new computer by going to Tools » Register » Print Registration Form or email the registration information by 
going to Tools » Register » Email Registration

Removing The THERAPIST from your Old Computer 

. If you print the form, you can fax it to the fax number on the form or mail it to the address on the 
form. The form is a self-mailer so if you don't have a fax machine just fold on the lines, tape it closed, add a stamp, and put it in the mail. 

If you have purchased a multiple installations and the new installation falls within the limitations of the number of installations purchased, there may 
be no need to remove The THERAPIST from the old computer. 

If your old computer has died, rest in peace old computer. You may be asked to verify this in order to obtain a synchronization code for the new 
computer. 

IMPORTANT! Do not disable The THERAPIST on your old computer until you have it installed on the new computer, your 
data has been restored on the new computer and you have verified that everything was successfully 
transferred to the new computer. 

To avoid a charge for a secondary installation, you can print and send us a Removal Verification Form from your old computer. This form must be 
submitted before we will issue you a Synchronization Code for the new computer. You should have 10 days after installing The THERAPIST on the 
new computer before the program will refuse to run without the code. To disable The THERAPIST and print the Removal Verification Form please 
follow these steps on your old computer: 
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1. Start with The THERAPIST closed. 

2. Run The THERAPIST. The first thing you will see is a selection screen where you select which program to run. Your choices are The THERAPIST 
Pro, the Administrator Utility, or Support Information. Choose the Administrator Utility

3. Log into the Administrator Utility with your normal login for The THERAPIST then go to 

. 

File » Disable The THERAPIST

4. When this process is complete a Verification form will be sent to your printer that you can either mail or fax to us using the information on the 
sheet. 

. You will have a couple of 
chances to change your mind because this renders The THERAPIST not usable. 
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39. Frequently Asked Report Questions 

User-Defined Fields 
Why would one use patient or service categories versus user-defined fields? 

Obviously, there are similarities between user-defined fields and patient or service categories. Both let you define the entity and the allowable 
responses. However, user-defined fields are more limited in the number of responses you can define. Categories, on the other hand, are completely 
open-ended; you can have as many choices as you want. The other reason to use categories is because you can use them as criteria for reporting. 

User-defined fields are more flexible than categories, especially with regard to how you make a selection or enter a response. A user-defined field 
can be defined to use a drop list, a series of radio buttons, or an unrestricted text entry box. For the latter, the size is limited to 50 characters but 
the content is not otherwise validated. This might be a good thing or a bad thing depending on how you are using it. 

Report Questions 
Why doesn't the report's progress indicator correspond with the actual progress? 

There are two ways this can appear. 1) the progress bar sometimes goes to 100% but stays there for a considerable period or 2) the progress bar 
goes only part of the way then the report is printed or previewed. In both cases, the answer is the same. All progress bars work by counting 
something (for example lines printed in a report) and comparing the current count with the total count and displaying it as a percentage of the 
total progress bar length. The total count is the 100% point and this count must be known in advance in order to determine the actual progress. 

Unfortunately, knowing the total count in advance is usually not possible without actually going through the entire reporting process and that 
would mean doing everything twice and doubling the amount of time it takes to print the report. Instead, the program estimates the 100% point 
based on the count the last time the report was printed. But since you may set different report options (e.g. choose a different date range or select 
a different number of providers to include), this estimate can be too high or too low resulting in an inaccurate progress bar. 

Claim Questions 
How do I fill CMS-1500 box 32? 
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